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 FeatureCAM 3D Machining Feature Comparison 

 

 FeatureCAM has now been split into three levels. Standard, 

Premium and Ultimate. The next few images show the available 

options for all modules. 
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Standard 

 The image below show the available options in Standard 

FeatureCAM 

 

 It is here that you will see the activated products that you have 

purchased.  
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Premium 

 The image below show the available options in Premium 

FeatureCAM. 

 

 It is here that you will see the activated products that you have 

purchased.  
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Ultimate 

 The image below show the available options in Ultimate 

FeatureCAM. 

 

 It is here that you will see the activated products that you have 

purchased.  
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 All 3D Strategies available for Ultimate machining 
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3D Premium and Ultimate Machining 

Introduction 

 

 The following training notes will cover 3D Machining strategies. We will 
start with a model that will give you the ability to try out different 
Roughing and Finishing strategies.  This will give you an understanding 
of the capabilities within each strategy. By the end of the course you will 
be able to machine complex 3D Components. 

Finishing Basics 

FeatureCAM has wide variety of methods for finish machining parts. The 
strategy that is chosen will depend upon the part geometry, the type of stock 

and the available cutting tools. By choosing the most appropriate combination 
of strategy and tooling the user can greatly reduce the time taken to finish 
machine a part. The strategy chosen can also have a large influence on the 
surface finish achieved. 

Leave Allowance, Tolerance and Stepover 

When FeatureCAM is finishing a part, the main considerations are accuracy, 
surface finish, and speed of calculation. These are generally governed by the 

choice of tool, strategy, tolerance, and stepover. The tool and strategy choices 
largely depend upon the shape of the part that is being machined and will be 
covered in later modules. For now we will consider the leave allowance, 
tolerance, and stepover. 
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Leave Allowance 

The Leave Allowance is the amount of material left on the part by the finish 
machining process. By default this is zero, the part will be finished to size. If 
the user wishes a positive leave allowance can be given, this will leave additional 

material on the part for subsequent processes. The leave allowance can also be 
negative this will cut the part undersize.  
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Tolerance 

The toolpaths produced by FeatureCAM consist of a number of straight line 
moves which move the tool across the surfaces to be machined. The length of 
the moves produced depends upon the tolerance value and the curvature of the 

surface being cut. The Tolerance is the maximum deviation of the tool from the 
surfaces being cut, for example a tolerance of 0.125mm means that the tool 
will not deviate from the surface by more than 0.125mm along the direction in 
which it is cutting. On a convex surface this will be the maximum amount of the 
permissible cut into the surface, on a concave surface it will be the maximum 
amount of material that will be left on the surfaces being cut. 

The Tolerance controls the accuracy to which the toolpath follows the shape of 
the work-piece. With a coarse tolerance the toolpath is more faceted, as fewer 
moves are calculated for each profiling move. 

 

Large Tolerance    Small Tolerance 

 

 The effect of tolerance on a toolpath in a vertical plane (Parallel 
toolpath). 

 If a very fine tolerance is chosen for a roughing operation, it may take 
a long time to calculate the toolpath to an unnecessary accuracy. The 
optimum Tolerance value will depend upon the user balancing the 
required accuracy against the time taken to calculate the toolpath.  

 It should also be noted that tolerance required will also depend upon 
the curvature of the part being machined. Where a surface has a large 
radius of curvature a smaller tolerance will be required to prevent 
faceting of the part. 

Stepover 

The tolerance controls the accuracy with which the part is machined along the 
direction of travel of the tool. The distance by which the tool steps over between 
each tool pass will control the surface finish. In FeatureCAM, there are a number 
of ways in which the distance between passes can be controlled. It may be an 
explicit stepover either in the XY plane, along the surfaces, a vertical stepdown, 
or Z increment. Certain toolpath types allow the user to specify a scallop height. 
This is the height of the ridge in between the furrows left by the tool.  
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Large Stepover 

 

 

Small Stepover 
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 It is common practice to calculate toolpaths with a large tolerance 
and stepover while experimenting with different strategies. Once the 
strategy looks correct, the user can then tighten up the tolerance and 
stepover for the final manufacturing calculation. This can save a great 

deal of time when working on large parts which will need to be 
finished to a high accuracy and surface finish.  

Finishing Strategies 

 

1 Import your solid Model 

2 Select Ctrl+R to activate a New Feature. Select Surface Milling. 

 

3 Select Next. 

4 Manually select the solid model by windowing the part and then select the Green 
+ key to select all of the surfaces on the solid model. As shown on the next 
page. 
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5 Select Next and you will be given two options.  

6 Option One. This will allow you to machine automatically any part using 
Roughing and Finishing strategies. We will cover this later on in the chapter. 

 

7 Option Two. Choose a single operation allows you to choose a strategy from 
another menu. Please select this option. As shown on the next page. Select 
choose a single operation option. One strategy at a time. 



              
 

                 Introduction to Ultimate 3D         

 

                                                                                                                                      

                                                                                                              
 Autodesk FeatureCAM 2017   

1.8                                                                                                                  © Copyright 2016 Autodesk, Inc. All rights reserved 

 The 3D Machining strategies will be explained in detail. 

 

Parallel 
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 Parallel - Projection milling techniques are a robust and easily understood 
method of generating 3D toolpaths. They work by taking a pattern of curves 
and projecting points from these curves onto the surfaces of the part. 

Advantages 

 The strategy is very robust.  

 The strategy handles overlapping surfaces well.  

 It is good for multiple surface manufacturing.  

 It lets you specify planar stepover distances or scallop heights for 
finishing.  

 Surface normals are not considered for the manufacturing computation. 

Disadvantages 

 It has poor handling of near-vertical surfaces.  

 It does not handle vertical surfaces because they are invisible from above. 
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Z Level Finishing 

 

 

 Z Level Finishing - The Z Level Finishing method slices the feature at 

various depths, and then mills each slice.  This is a good technique for 
finishing steep walls or when you require a consistent depth of cut. This 
technique is sometimes called waterline milling. Just like Z Level Rough, it 
starts with slicing the model and then creating toolpaths from the slices. 
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Isoline 

 

 

 Isoline - Uses the isoline curves of a surface to mill the surface. These 
curves can be in the row direction or column direction. 
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 Advantages - Uniform finish with scallop height control. The toolpaths are 

spaced based on the distance along the surface. Nearly-vertical walls 
handled well. Because this is not a projection technique, nearly vertical walls 
are cut correctly. 

 Disadvantages - Toolpaths generated on a surface-by-surface basis. 
Restrictions of Isoline milling. 

 Isoline - milling works on a surface-by-surface basis. This can result in 
numerous retracts. The orientation of the surfaces matters. Toolpaths are 
generated for surfaces whose normals point up. Surfaces are 'auto-flipped' 

where possible, but for vertical and some other cases, you must specify the 
machining side. Select the surface in the list and click Switch machining 
side. Isoline milling may mill on the wrong side of the surface or if certain 
flags are set, it may skip the surface. 

2d Spiral 
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 2d Spiral - Will mill a feature with a pattern of offset toolpaths. The pattern 
is obtained by taking the stock boundary, the feature boundary or the curve 
specified on the Stock tab and offsetting this curve toward the center of the 
part. The pattern can be cut either towards the feature center or away from 
the feature centre. 

 The steps between the passes are calculated in 2D. For spiral toolpaths that 

use a 3D stepover use the 3D spiral technique. To use the stock boundary, 
select Use stock dimensions on the Stock tab. This results in a square shape 
to the toolpaths. 

3d Spiral 
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 3d Spiral - This finishing technique is best suited to machining areas that 
need a constant stepover and works well on near-horizontal faces. 

 Spiral toolpaths mill a feature in a series of offsets towards the feature 
centre. The initial pattern is specified by taking the stock boundary, the 
feature boundary, or the curve specified on the Stock tab. 

Radial 
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 Radial - This strategy creates a radial pattern within a boundary and 

projects it onto the model.  

 Centre point. The centre of the radial pattern is calculated automatically 
unless you set a Centre point. This point is projected down onto the 
surface to become the centre of the radial pattern. 

Flowline 
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 Flowline - This technique projects the isolines from one surface onto the 
surfaces of the feature. The isolines are projected in the direction of the 
surface normal.   

Between 2 curves 
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 Between two curves – This calculates toolpaths that are bounded by two 
curves. This finishing operation is used to control the shape of the toolpath 
over multiple surfaces by restricting the machining of the surface to be 
between the two specified curves. The toolpaths mill a feature in a series of 
offsets starting from the first or start curve towards the second or end curve. 
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Specialised Strategies 

Horizontal + Vertical 

 

 

 Horizontal + Vertical - This strategy combines two different toolpath 
operations, one for finishing shallow portions of the part and one for 
finishing the steep regions. 

 An X parallel or spiral toolpath is applied to the shallow regions, and a Z 
level finishing operation cuts the steep regions. 

 The attributes available on the Milling tab are different for each operation: 
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Corner Re-Machining 

 

 

 Corner Remachining - This is used to automatically mill regions that were 
not cut by previous operations. You provide the diameter of the previous 
tool that was used to cut the part and FeatureCAM automatically 
determines the uncut regions and applies a toolpath to them. 

 Corner Remachining is used to clean up corners that occur between non-
tangential surfaces. Each corner edge is called a trace line. By using the 
options on the strategy page, you may cut in various directions relative to 
the trace lines. 

 Corner Remachining is available in four different styles: Along, Across, 
Combo along and across, and Multi pencil. 
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Pencil 

 

 

 Pencil - This strategy creates a single trace corner toolpath. It is used to 

clean up corners that occur between non-tangential surfaces. They are 
automatically calculated inside any existing boundary. 

Applications for pencil milling include: 

 Finishing fillets in a part with a single toolpath.  

 Cleaning up sharp concave corners.  

 Pre-relieving corners before high-speed finishing the part with a small tool.  

 Roughing fillets by using the Finish allowance. 
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Swarf 

 

 

 Swarf – Swarf cutting calculates toolpaths that cut with the side of the tool 
and works only on developable surfaces because the tool needs to be in 
contact with the surface for the whole cutting depth. 

 For a tool to Swarf cut, it has to be able to have contact with the surface at 
all points along the cutting edge of the tool. For a non-developable surface, 
FeatureCAM always leaves material on or produces fragmented toolpaths 
(rather than gouge). This means that you need to look at parts carefully 
before trying to Swarf cut them. It may be that rotating the part (cutting 
from the side rather than the top of an aerofoil blade) produces the desired 
result. 



              
 

                 Introduction to Ultimate 3D         

 

                                                                                                                                      

                                                                                                              
 Autodesk FeatureCAM 2017   

1.22                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

 Swarf machining makes every attempt to machine the selected surfaces but 

you may have to consider running more commands including ones with 
different options for Swarf milling to obtain the best machining results. 

 It is possible to identify approximately whether a surface is developable and 
ruled by shading and also displaying its wire frame geometry within 
FeatureCAM. You can then orientate the view to be roughly down the 
expected tool axis vector. 

Steep and Shallow 

 

 

 Steep and Shallow - This strategy calculates a shallow boundary, and then 
creates a Z-level toolpath in the steep areas of the model and a Parallel or 
3D Spiral toolpath in the shallow areas. 
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Surface Milling Properties 

 You can use the Surface Milling Properties dialog to edit the 
properties of a 3D Surface Milling feature. 

 

Feature-level tabs 

The top level of the tree view is the feature level. Select the feature name at 
the top of the tree view to access these tabs: 

Dimensions — Use this tab to specify the Part and Check surfaces. 

Select Part Surfaces dialog 

 You can use the 3D Part Surfaces dialog to pick surfaces you want to include 
in your 3D part feature. 

 Select the surface(s) in the list or click the Pick surface button and select a 
surface with the mouse. To pick additional surfaces, click the Pick surface 
button again before selecting each additional surface.  

 Click OK to return to the Feature Properties dialog.  

 Click OK and Apply to apply your surface selection to the feature and return 
to the Feature Properties dialog. 

 You need to consider the following when specifying part surfaces: 

 You cannot manufacture undercut surfaces using 3-axis machining, so it is 
a good idea to use only surfaces in the feature that can be cut from the 
setup.  
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 Some surfaces may be cut from multiple setups to manufacture all parts of 

the surface. In such situations, a Stock Curve is helpful in limiting the 
machining area to just those spots that need it. 

Select Check Surfaces dialog 

 

 Use this dialog to select surfaces that you want to use to limit machining. 

 Check surfaces are surfaces that denote areas that you do not want to 
machine. Select surfaces that are more horizontal than vertical. A check 
surface acts as a boundary up to which milling occurs. 

 If you select a vertical check surface the milling may resume on the other 
side of it if the surface to be milled extends beyond the check surface. 

 Select the surface(s) in the list box or click Pick and select a surface with 

the mouse. To pick additional surfaces, click Pick again before selecting each 
additional surface.  

 Click OK to return to the Feature Properties dialog.  

 Click OK and Apply to apply your surface selection to the feature and return 
to the Feature Properties dialog. 
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Location 

 Location — Use this tab to reposition the feature relative to the surface. 

 

Process — Use this tab to create, delete and reorder the operations of the 

feature. New Operations can be added using the existing selected surfaces. 
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Machining Side — Use this tab to control which side of surfaces to machine 

Misc — Use this tab for a variety of feature-level attributes 

Strategy-level tabs 

The next level is the strategy level. Select a strategy in the tree view to 

access the following tabs: 

Strategy — Use this tab for rough/finish classification, edge protection, and 
re-machining 

Edges — Use this tab to choose how the tool behaves at the limits of the part 
surfaces as seen from the top view. 

 

The Edges tab is not available for Z-level roughing or Swarf finishing 
operations. 

Stock — Use this tab to choose the clipping curves for the material to be 
removed 

Slopes — Use this tab to set slope angle limits for restricting toolpaths 

The Slopes tab is not available for Z-level roughing, Plunge roughing, 
Isoline finishing, Flowline finishing, horizontal + vertical and Swarf. 
Strategies. 

Surface Control — Use this tab to exclude feature surfaces for specific 
operations 
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Operation-level tabs 

The third level is the operation level. Select an operation in the tree view to 
access the following tabs: 

Tools — Use this tab to view selected tool or change to a different one. 

 

F/S — Use this tab to view automatically calculated feed or speed or change 
feed or speeds 
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Milling — Use this tab to set operation-level attributes. 

 

Leads — Use this tab to control leads and ramps. 
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Roughing Strategies 

 FeatureCAM has a number of different methods for Rough 
machining parts. The strategy that is chosen will depend upon the 
part geometry, the type of stock and the available cutting tools. By 
choosing the most appropriate combination of strategy and tooling 
the user can greatly reduce the time taken to machine a part for finish 
machining. In the roughing course module we shall look at the three 

main Roughing toolpath types in FeatureCAM. These are Z Level 
Roughing, Plunge Roughing and Parallel Roughing. We shall 
also consider different stock types and finally take a look at high 
speed and high efficiency Roughing techniques. 

Z Level Roughing 

 

 Z Level Roughing – This is commonly known as waterline 
machining. In Z Level and Parallel Roughing a series of horizontal 
slices is taken through the part. At each level the profile of the part 
and the outline of the stock define the area of material to be the 
chosen strategy and tooling.  
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 You can rough your part as a 3D Pocket, or as a 3D Boss. If you select 3D 
Pocket, the tool plunges or ramps onto the part and cuts from the inside of 

the part out toward the boundary of the part. A 3D Boss typically plunges 
off the part and cuts from the outside toward the centre. 

 Even if the surfaces of your part create a boss shape (meaning it protrudes 
instead of being a cavity); you can still select 3D Pocket.  

 Specify the style of toolpath. If you select Zig-zag, this roughs the part 
raster-style with an optional profile around each Z-slice (optionally select 
the Profile contour option). 

 The value can be anywhere from -360 to 360 degrees, the default is 0.0. A 

positive value rotates counter-clockwise from the principle axis, and a 
negative value rotates clockwise from the axis. 

 Setting the angle to 90 on an X-parallel operation causes it to effectively 
become a Y-parallel operation.  

 Setting the angle to 180 causes the toolpaths to be cut from the opposite 
side of the part. For example, an X-parallel operation with the angle set to 
0 starts at the minimum Y coordinate. With the angle set to 180, the 
toolpaths start at the maximum Y coordinate. 

 Continuous spiral - This option enables the tool to move in a continuous 
smooth spiral motion and reduces tool load. 

 Vortex (3D HSM) - An offset toolpath, which is machined at the specified 
cutting feed rate almost all of the time. The optimum tool engagement angle 
is never exceeded, by replacing difficult toolpath segments with trochoids. 
This works well for solid carbide tools. 
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Classify slices as 

Offset Direction options. 

 Automatic - The tool cuts from the outside to the inside of the stock in a 
continuous radial movement. This is the default option.  

 In to out - The tool plunges into the stock and cuts outwards.  

 Out to in - The tool cuts from the outside to the inside of the stock. The 
tool outlines the surfaces and cuts large sections last.  

 Remachining — click this button to open the Remachining dialog. 

 Area Removal (3D HSM) 

 Remove unsafe areas - This removes small toolpath segments to prevent 
tool damage when using non-centre cutting tools. When machining into 
small pockets, removing small segments stops the central, non-cutting 
underside of the tool from hitting non-machinable material. Unsafe segment 
removal filters out the machining of confined areas with small movement of 
the cutting tool. 

 Remove area less than -This removes segments that are smaller than the 
entered percentage of the tool's diameter, unless they surround a Boss 
feature. 

 Closed areas only - Select this option to remove segments, in enclosed 
areas, that are smaller than the Threshold value. 
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Plunge Roughing 

 

1 Select Next to show the next menu. 
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2 Select Next to show the menu below. 

 

Milling Menu 
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 The tool rapidly removes the material from the part by a series of drilling 

operations along parallel lines in the X direction. The distance between 
the parallel passes and the shape of the part determines the amount of 
material left on the part after plunge roughing.  We will now make the 
distance between the passes smaller to reduce the steps in the remaining 

stock. 

 There are two attributes which control the way that the plunge roughing tool 
steps over along a single roughing pass and between each pass. We shall 
now look at the effect of each. 

 The first is the Rough pass stepover %.  

 This sets the spacing between each drilling operation along a roughing pass. 
The stepover is a percentage of the tool diameter.  

 

 The second attribute is the Next row stepover % this is the distance 
between each pass. The default value is 80%; with our 50mm diameter 
plunge rougher this is giving a stepover of 40.6mm leaving large steps. 

 

 When setting these two attributes, the user should take care to ensure that 
only the cutting portion of the tool is plunging into the stock. Where an 
insert tool is not centre cutting it is very important to ensure that this will 
not be plunged into the stock. Failure to do this can result in damage to the 
tool, the part, and also the machine tool spindle. 

 Set the Next row stepover and Rough pass stepover both to 33%. 

o  

3 Set the Z start to -2.5mm. 

 By putting the Z Start below the top of the material we are ensuring that 
we do not waste time by plunging into material at the top of the part that is 
very thin. 
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 Plunge Roughing provides an alternative form of roughing. With this 

technique, roughing is performed with a series of overlapping holes. The 
advantage of using this technique is that parts can be roughed quickly 
because the force of the operation is directly up the spindle. 

 This figure shows a sphere that is being plunge roughed with a flat end tool. 

 The pattern of drilling operations is parallel to the X or Y axes just like 
parallel milling. Neighbouring rows of the pattern can be offset horizontally 
to better cover the part. 

 Plunge roughing is performed in either a straight rectangular pattern, as 
shown below: 

 or a honeycomb pattern in which each row is offset horizontally by half the 
rough pass stepover amount: 

 The honeycomb pattern is usually preferable. The Honeycomb pattern 
attribute controls the pattern type. 

 The Rough pass stepover % attribute controls how far the holes in the same 
row are spaced. It is specified as a percentage of the tool's diameter. 

 

Parallel Roughing 
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Introduction 

Parallel roughing is similar to Z Level Zigzag in that the toolpaths are parallel 
to an axis, either X, Y or at an arbitrary angle. Unlike Zigzag the user does not 
have the option to make a profiling pass at each level. Instead of profile passes 

the strategy makes a 3D Parallel semi-finish toolpath over the whole part to 
remove the cusps left by the initial roughing operation. Due to the nature of the 
toolpath the default tool chosen is a ball nosed cutter. We will now rough 
machine the engine casing using a parallel roughing strategy. 

1 Click on Features in the Step view or select Ctrl + R 

2 Check Surface Milling and press Next twice.  

3 On the New strategy form check Choose a single operation. 

4 Click Next. 

5 Check Parallel in the Roughing Strategies part of the form. 

6 Press Finish. 

7 Edit the feature by double clicking on it in the Part View window. 

8 Click on rough1 in the tree view. 

9 Select the Milling tab and set the Z increment to 10mm as below. 

10 Check Skip final Pass, click Apply then OK. 

 

11 Click on the Tools tab and select a 25mm Ball Endmill. 

12 Run a Centreline simulation. 
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 The tool path runs parallel with the x-axis at the Z-increments 
specified. Note the ramping approach moves, these are needed where 
a non-centre cutting tool is approaching the stock from above. We 
will deal with ramp moves in detail further on in these notes. 

13 Run a 3D Rapid Cut Simulation  

 

 Note the large cusps left between each pass along the X axis. We 
will now reduce these by adding a semi-finish pass. 

14 Click on rough1 in the tree view. 

15 Select the Milling tab and uncheck Skip final pass. 

16 Click Apply and then OK. 

17 Run a 3D Rapid Cut simulation  
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 The tool path now has a final pass that is parallel to the x axis that 
changes in z according to the contour of the part. Note how the very 
top of the part is not machined. In order to ensure that the semi-
finish pass goes all the way across the part we need to put additional 

stock on top to a thickness greater than the Finish Allowance. You 
will also notice that where the part forms is steep in a direction 
perpendicular to the cutting direction the stepover leave large cusps. 
We will now fix these two problems. 

 

18 Edit the feature, select parallel in the tree view. 

19 Check Add perpendicular re-machining pass.  

20 Set the Steep slope angle to Zero degrees.  

 

21 Click Apply and then OK. 
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22 Run a 3D Rapid Cut simulation. 

 

 By setting the steep slope angle to zero we are forcing FeatureCAM to 
semi-finish in two passes one along the X direction and the second along 
the Y across the whole part. This technique can be useful when cutting 
very large parts with a ball nose cutter. If a larger Steep slope angle is 
sent then only that portion of the part that is steeper that the specified 

angle perpendicular to the X direction will be re-machined. 

Edges 

 

 This tab gives you options to set how the toolpaths are generated 
near surface edges. 

 Automatic — a set of rules that chooses between don’t roll and 
Cut to bottom to get the best performance. 
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 Cut to bottom: Roll over top edge and cut to bottom of stock/part 

limits — this does not set any boundary. In this case, FeatureCAM uses 
only the boundary specified by the curve options in the Stock tab. 

 Cut top edge: Just roll over the top edge — Sets a pocket-like curve 
boundary to the silhouette of the part offset by a tool radius. The tool rolls 
over the edges by a tool radius. In PowerMILL this is known as a silhouette 
boundary. Edge boundary uses a silhouette boundary of the part, but it uses 
the top (highest) Z values where the silhouettes are at a vertical surface. 

 Don't roll over the edge at all 

 Sets a pocket-like curve boundary to the silhouette of the part. The tool 
contacts the surface boundary. In PowerMILL this is known as a contact 
point boundary. This prevents any cutting of sharp corners at the external 
edges of the part. If the part has a vertical surface at the outside of the part 

and has a sharp corner at the top of the vertical surface, it prevents cutting 
of the vertical surface because it is coincident with the sharp corner at the 
top. 

 You can set advanced options on the part boundary by clicking the advanced 
button. 

 If you have a vertical surface and you want to cut to the bottom, select cut 
to/from bottom of vertical walls. 

 Cut selected surfaces: Only cut selected part surfaces — FeatureCAM 

only machines the selected surfaces and does not cut any of the 
neighbouring or unselected surfaces. If there are no neighbouring surfaces, 
the tool rolls over the edges by a tool radius. 

 If you have a vertical surface and you want to cut to the bottom, select cut 

to bottom of vertical walls. 

 Save Combined Boundary — this preview button shows both the part 
boundary (in blue) and the tool centre (in red) curves on your model and 
enables you to save it for future use if you want to. 
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Stock Types and Boundaries 

Introduction 

So far in this module we have only considered roughing from a rectangular 

block of material. Often in practice we may have material that is round or 

multisided, has been pre-machined, or may be a fabrication or a casting. We 

will now examine the different options available for defining the type of stock 

we are using. The first one we will look at is Round Stock. 

 Close down all documents in FeatureCAM. 

 In Windows Explorer navigate to the Data folder. 

 Drag and Drop the file Round.x_t into the FeatureCAM graphics area. 

 Select a Metric Milling document and click OK.  

 Select “Use the Wizard” and Uncheck Launch AFR. 

 Click Next three times until you reach the Stock Type page. 

 Check Round and Z then click Next. 

 In this case our part is round and has its axis pointing up the Z axis. 

We now need to ensure that the round stock is centred on our part. 

 Click on Centre of revolved surface button. 

 Click on the surface shown on the next page. Shade the solid if necessary. 

 

 FeatureCAM finds the central axis of the selected surface and 

aligns the stock to it. 

 Click Next. 
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 Fill in the stock dimensions as shown and then click Next. The extra stock 

on the bottom is to hold in a chuck. 

 

 The next step is to position the setup at the required position. In 

this case we want it to be at the center of the upper end of the 

stock. 

 Click on the Hand to the Right of the stock on the form. 

 Click Finish. 

 The part is now correctly set up within the resized stock. We will 

now create a Z Level Offset roughing path to clear the excess 

material from around the part. 

 Click on Features in the Steps view. 

 Check Surface Milling and press Next.  

 Box select all of the surfaces and then press the Add from selected 

items button  then click Next. 

 On the New strategy form check Choose a single operation. 

 Click Next. 

 Check Z Level in the Roughing Strategies part of the form. 

 Click Next. 

 Fill in the Strategy form exactly as below and then press Finish and OK.  

 Run a Centreline simulation.  

 Change to a Top View. 
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 Note how the roughing passes are now confined to a cylindrical area 

around the part. 

N-Sided Stock 

FeatureCAM can also create stock with a regular polygonal form such as 

hexagonal bar stock. The stock size is defined by its number of sides and outer 

diameter (circumscribing circle). 

 Double click on the Stock in Part View and fill in the properties as shown. 

 Apply and OK. 
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 Edit the surface mill feature, select rough1 and then the Milling tab. 

 Set the Z increment to 2.5mm and Z End to -5mm as shown. Apply 

and OK. 
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 Run a Centreline simulation. 

 Change to a Top View. 

 

 The roughing operation is now confined to a hexagonal region 

around the part. 

 Run a 3D simulation.  

 Change to as Isometric View. 
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 Note: how the hexagonal stock is accurately represented in the 

simulation. 

Stock Curve 

Often a part has to be machined from a billet that has been pre-machined into 

an irregular prismatic form. For example the outline of the part may have been 

cut out using a band saw or machined using a 2.5D feature such as a Side or a 

Boss. It would be very inefficient in such a case to prepare a roughing toolpath 

based on a rectangular or round stock when most of the material has already 

been removed. A Stock Curve allows you to define the outline of the remaining 

material and then rough just within that area. 

1 Import the part Primary_Case.x_t  

2 Use the import Wizard to orientate the part and create Setup1 and setup 

the Stock as described in the first chapter Roughing Strategies. 

3 Select the bottom flat face of the solid model using your cursor. 

4 Then select Ctrl + K. This hides everything apart from the selected surface. 

 

 We will create a Curve from the outer edges of this selected surface. 

5 Select Construct>Curve>From Surface>Surface Edges. 

 See image on the next page. 
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6 Select the Pick Curve on surface Icon and double click on the outer shape 

 Wait a few seconds and FeatureCAM will then create a Curve from 

the outer edge all the way around. 

 

 

7 Click Apply and OK. 
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8 Change to an Isometric View. 

9 Offset the Curve by 5mm. 

10 Select Construct>Curve>From Curve>Offset. 

 

 

11 Double click on Stock in PartView. 

 This will show you the Stock Menu as shown on the next page. 
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12 Select Stock Curve and pick the Curve you have just created using Offset. 

13 Select Apply and OK.  

14 In PartView select Stock and Right click then select Show Stock. 

15 Or Select Ctrl + L this will Show All. 

 

 You will see that FeatureCAM is now using the curve to define the 

stock as an extrusion of the outline of the remaining material. The 

thickness of the material defaults to the previous thickness of the 

rectangular block but can be changed if required. 

16 Box select all the surfaces. 

17 Create a Z Level Rough. Use Offset/Spiral and Boss in the strategy. 

18 Finish and OK 

19 Run a Centreline Simulation.  

 Only the area within the stock curve is roughed out. 
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20 Run a 3D Simulation. 

 

 Simulation paused to show Material. 

Total Stock 

If the part is being machined from a casting or fabrication it may have an even 

thickness of material left on all of the surfaces. In such a case using a stock 

curve will result in the roughing making unnecessary air cutting moves. 

Fortunately in FeatureCAM we can allow for this by using the Total Stock 

attribute. By setting a total stock value we are telling FeatureCAM explicitly 

how much material is left on the part as a uniform thickness across the whole 

model. 

21 Edit the surface mill feature, select rough1 and then the Milling tab. 

22 Set the Total Stock to 3mm and Z Increment to 1.25 as shown. 
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23 Apply and OK. 

24 Run a Centreline Simulation.  
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 The tool is now making a single roughing pass at each level to clear 

the remaining stock. 

Stock Solid 

When using Total Stock the remaining material is defined as an even thickness 

over the whole model. In practice however, the stock form is often only a 

simplified version of the finished model, and may include runners, risers and 

other features required by the manufacturing process. FeatureCAM allows the 

user to represent the stock using a solid model. Where a solid is used as the 

stock, the roughing process will only remove material between the solid stock 

and the part being machined.  

1 Open the part Primary_Case_Stock_Model.fm 

 In this part there are two solids, one (part model) represents the 

part to be roughed, and the other (casting) is to be used as the 

stock material. 

2 Show all and then hide the solid part_model. Shade if necessary. 

 

 This solid (casting) is the same as the part model except for certain 

changes; the recesses where the screw holes were have been filled 

in and casting sprues have been added. The aim of the following 

roughing process is to clear the area around the screw holes and 

remove the sprues using the minimum amount of roughing moves. 

Note the runner (to the right) and the risers (to the left). We will now 

prepare a roughing program to remove these from the part model 

and to rough out the recesses 

 Double click on the stock. 
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3 Change the Stock type from Block to User defined. 

4 Click on Stock Solid. 

5 Check the solid casting and then click the OK and Apply button. OK. 

6 Run a Centreline Simulation then a 3D Rapid Cut simulation. 

 

 You will see that the stock in the 3D simulation is the solid “casting” 

but that the actual roughing toolpaths are still sized to the previously 

defined block. We need to make one more change to allow 

FeatureCAM to calculate the roughing paths from the stock solid. 

7 Eject the simulation. 

8 Edit the feature srf_mill1. 

9 Select the z level feature and then click on the Stock tab. 

10 Check Use solid model then select casting from the pull-down menu. 
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11 Apply and OK. 

12 Run a Centreline Simulation then a 3D RapidCut simulation. 

 

 Note how the roughing now machines only those areas between the 

finished part and the stock solid. This eliminates a lot of air cutting.  
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Pocket/Boss 

In all of the roughing operations so far we have used the default 3D Boss option 

on the Strategy tab. We will now take a look at the 3D Pocket option and how 

it differs from the Boss. The main difference between these two options is that 

with a Boss the tool will approach the part horizontally from outside of the stock 

if possible. If the feature is defined as a Pocket the tool will approach the part 

from above either by a plunging move or by ramping.  

13 Open the part Primary_Case_Pocket_Boss.fm 

14 Run a Centerline Simulation and then a 3D Simulation. 

 

 

 You will see that as the part is roughed out of the block stock the tool 

approaches the outer areas by plunging outside of the block, the 

inner, enclosed areas are approached by a ramping (blue zigzag) 

move from above.  
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 Often when roughing such a part the stock may be clamped on the 

outside, or the material may have been roughed earlier by cutting 

from the opposite side of the block. In such a situation the user would 

probably want to machine only the center pocket of the part and leave 

the outer area. We can do this by switching from the 3D Boss option 

to a 3D Pocket. 

15 Edit the feature srf_mill1 and click on z level. 

16 Click on the Strategy tab and check 3D pocket. Apply and OK. 
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17 Run a 3D Simulation. 

 

 

 FeatureCAM is now looking for enclosed pockets so the area outside 

of the part is not machined. This only happens because there are NO 

Part Surfaces selected outside of the area to be machined. If any 

surfaces outside of the pocket area are selected then they would be 

machined also, however, the selected areas outside of the pocket 

would be approached from above by ramping moves and the tool 

would not go outside of the block. This can be useful when machining 

a part that is held in soft jaws with the minimum amount of damage 

to the jaws. 

 We will now add in extra surfaces to the Part surface list to force 

FeatureCAM to rough outside of the part as well as inside while 

restraining the toolpath to the stock outline.  

18 Right click on the solid Base in the Part view and Show selected. 

19 Edit the feature srf_mill1 and click on Part surfaces. 

20 Select the face face_267 and add it to the part surfaces list. 

21 Click OK and Apply then OK. 

 Note: face_267 is the upper face of the solid called base. 

22 Run a Centreline Simulation and then a 3D Simulation. 
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 Notice how the toolpath now remains inside the outline of the stock 

and approaches by a ramping move from above in all cases. The final 

roughing pass is above the surface face_267 by a distance equal to 

the finish allowance plus the tolerance. 
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Use of Boundary Curves 

 It is often convenient to limit the area to be machined using a 

Boundary. A boundary is a curve which is used to define an area of 

the part that is to be machined. The area to be machined may be 

either within the curve (a boundary) or outside of the curve (an 

island). Multiple curves may be used to define “nested” roughing 

areas as long as the curves do not cross. In this first example a simple 

curve will be used to limit roughing of the upper side of the primary 

case model.  

23 Open the part Primary_Case_Boundaries.fm - This is an Inch 

Document. 

24 Run a 3D simulation. 

 A 2.5D Boss feature has been used to rough out the billet. We will 

now rough out the remaining material using a boundary to minimize 

air cutting. 

25 Box select all the surfaces. 

26 Create a Z level surface mill feature. Offset/spiral and 3D Boss.  Finish.  

27 Select the Milling tab (rough1) in the Surface Milling Properties dialog. 

28 Set the Z Increment to 0.1”. 

29 Select the Stock tab (pick z level in the tree). 

30 Click on Select curves for boundaries. 

31 Click on Curve Options button. 
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32 Click on the Curves… button. 

 

33 Select the curve called profile. 

 

34 Click OK, OK then Apply and OK. 

35 Run a Centreline simulation. 

36 Run a 3D simulation. 

 The 3D roughing now only machines the material left after the initial 

2.5 Boss roughing operation. This gives a very efficient toolpath 

removing the maximum amount of stock in the minimum time. 
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 The first simulation shows the Boss operation and the finished 

simulation shows the profile boundary used in the Boss Operation. 

This is also used as a boundary in the Z level machining strategy. 
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Part Surfaces and Check Surfaces 

Select Part Surfaces dialog 

You can use the 3D Part Surfaces dialog to pick surfaces you want to include 

in your 3D part feature. 

Select the surface(s) in the list or click the Pick surface button and select a 

surface with the mouse. To pick additional surfaces, click the Pick surface 

button again before selecting each additional surface.  

1 Click OK to return to the Feature Properties dialog.  

2 Click OK and Apply to apply your surface selection to the feature and return 

to the Feature Properties dialog. 

You need to consider the following when specifying part surfaces: 

You cannot manufacture undercut surfaces using 3-axis machining, so it is a 

good idea to use only surfaces in the feature that can be cut from the setup.  

Some surfaces may be cut from multiple setups to manufacture all parts of the 

surface. In such situations, a Stock Curve is helpful in limiting the machining 

area to just those spots that need it. 

Check Surfaces 

Check surfaces are surfaces that denote areas that are not milled away. Use 

this dialog to select surfaces you want to use to limit machining in a 3D feature. 

Select the surface(s) in the list box or click Pick and select a surface with the 

mouse. To pick additional surfaces, click Pick again before selecting each 

additional surface.  

3 Click OK to return to the Feature Properties dialog. 

4 Click OK and Apply to apply your surface selection to the feature and return to 

the Feature Properties dialog. 

5 If you select any Part surfaces, they are allowed to be cut to the depth of the 

chamfer (in other words, the allowance is equal to - Depth). 

 If you select any Check surfaces, there is a Check allowance 

attribute on the Milling tab (the default is 0). 
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 The following example shows the difference between Part Surfaces and 

Check Surfaces. 
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 The following Toolpath has been created using Part and Check Surfaces. 
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All Strategies Start 

 We will start by importing a solid model into FeatureCAM which is in 

Parasolid format. You will find this in the FeatureCAM training folder 

C:\Training_Data\FeatureCAM Course Data 2017\3D 

Machining\ All Strategies Part-1.x_t 

1 Go to File>Import and navigate to the above location. 

 The image should look like the image shown below. Use the wizard to establish 

the part orientation and stock size. Leave as defaults. When you come to the 

stock just set the values to zero and select apply and then come out of the 

wizard. 
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2 We will now change the stock size to the main solid model part. 

3 Select the solid model in PartView and rename this to Part. 

4 Select Part in PartView and then go to Hide>Unselected. This will then 

only show the main solid model. 

5 Then double click on the Stock and select Resize and make all values Zero. 

The image below is how it should look. 

 

6 We are now ready to machine our part and will choose a Z-Level Roughing 

strategy to completely rough out our part. 

7 Select Ctrl+R to activate the New Feature menu. Select Surface Milling. 
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8 Select Next. 

9 Manually select the solid model by windowing the part and then select the 

Green + key to select all of the surfaces on the solid model. As shown below. 

 

10 Select Next and you will be given two options.  

11 Select Choose a single operation which allows you to manually choose a 

strategy from another menu. Please select this option. As shown on the next 

page. Select Next to activate the Choose a single operation menu. 



 
 
Roughing & Finishing Strategies 

                           

 

      
Autodesk FeatureCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           3.5 

 

12 Select Next. Then select Z Level Roughing. 

 

13 Select Next. 
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 By selecting 3D Boss (Default) the toolpaths will be working from the outside 

in. 

14 Select Next. Change the Tool group to Face Mill. Then select a 50mm 

Facemill from the drop down menu. You may have to make this longer. 
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15 Select Finish. Then select the Milling Tab and change the Z increment to 

3mm. Select Apply and Ok to close the form. 

 

16 Run a 3D Simulation to see the roughed out part. See below. 
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17 We now need to set the 3D Simulation shown above as a starting point, to 

save simulating again up to this point. 

18 Whilst the simulation is on the screen go to View>Simulation>Use Results 

as a Starting Point. Please select this option. 

 

19 Select Esc or Eject to cancel the Simulation. 

20 Rename the First machining operation to Z Level Roughing in PartView. 

 We will now machine the model working from Left to Right starting 

with a Parallel Finish machining strategy. To hide the 3D Roughing 

Feature please select the Surf_Mill? In PartView and then in the 

Right click menu select Hide. 

21 Create a New Feature Ctrl+R select Surface Milling. 

22 Select Ctrl+2 which is the Front View. 

23 Only select the left model by windowing around the part. See Example on the 

next page. 
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24 Select Next and then Choose a single Operation. 

25 Select Next and then Parallel Finishing. 

26 Select Finish. Then Double click on the new Surface Machining Feature in 

PartView. Rename to Parallel. 

27 We could check the bottom surface as a way of preventing the toolpaths 

machining below this surface. Select Check Surfaces. 

 

28 Pick the following surface as shown on the next page. 
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 Another useful option is to select Add perpendicular 

Remachining pass and Optimise Parallel pass. This will produce 

a better finished product.  

 Please experiment with different angles to achieve different results. 
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Z Level Finishing 

 Working from left to right on our model we will now use Z Level 

Finishing to machine our part. You may decide to do a pre-roughing 

operation first to take away the material away in the corners first. 

1 First of all select the surface that you want to machine. You know how to do 

this by now. See the image below. 

 

2 Create a new Feature Ctrl+R then Surface Milling. Select Next Twice then 

choose a Single Operation and then select Next. Select Z Level Finishing. 
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3 Select Finish. 

4 Rename this operation to Z Level Finishing. 

5 Double click on Z Level Finishing in PartView. 

6 Then select Z Level and then select the following options. Select Apply and 

then see Results below. 
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Isoline 

 Isoline machining works on single surfaces. Even if selected as part 

of a group of surfaces. Direction is set to None. This will give a 

continuous toolpath. Please set either Row or Column for cut direction 

for each surface selected.  

 The following is an example of machining selected surfaces using the 

Isoline surface machining strategy. It is more productive to have 

surfaces as one complete surface rather than individual surfaces. 

 Please use Powershape to make individual surfaces into one surface. 

Please select the following 3 surfaces. 

 

7 Create a new Surface Milling Feature. You know how to do this by now. 

8 Select Isoline. Then select Finish. Rename operation to Isoline. 
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 The following image shows the directions of cut for each surface. In order to 

create a uniform toolpath we need to change the direction of cut on the main 

surface. 

 

9 Double click on Isoline in PartView. Select Isoline and Surface Control. 

10 You will see the direction of cut as shown below. 
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11 Change the direction by selecting the Set isoline row/col icon. 

 

 

12 We also need to set Stepover to 0.5mm under the Milling tab and Leads to 

the following as shown on the next page. 

 The image shown on the next page shows the final toolpath. 
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2d Spiral 

 2d Spiral will mill a feature with a pattern of offset toolpaths. The 

pattern is obtained by taking the stock boundary, the feature 

boundary or the curve specified on the Stock tab and offsetting this 

curve toward the centre of the part. The pattern can be cut either 

towards the feature centre or away from the feature centre. 

1 Please select the following surfaces. Then create a new feature. Surface 

milling. Select 2d Spiral and select Finish. Accepting all defaults. 
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2 Rename the operation to 2d Spiral. Double click on 2d Spiral and change 

the Stepover to 0.5mm under the milling tab and then select Direction. 

 

3 Change Direction to Unidirectional. See results below. 
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 This will make the toolpath a continuous toolpath. 

3d Spiral 

 3d Spiral This finishing technique is best suited to machining areas that need a 

constant stepover and works well on near-horizontal faces. Spiral toolpaths mill 

a feature in a series of offsets towards the feature centre. The initial pattern is 

specified by taking the stock boundary, the feature boundary, or the curve 

specified on the Stock tab. 

1 Please select the following surfaces. Then create a new Surface Milling 

feature. Then select 3d Spiral. Select Finish. 
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 Edit the toolpath and change the stepover to 0.5mm 
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Radial 

 Radial: - This strategy creates a radial pattern within a boundary 

and projects it onto the model.  

 Centre point. The centre of the radial pattern is calculated 

automatically unless you set a Centre point. This point is projected 

down onto the surface to become the centre of the radial pattern. 

1 Select the following Surface. Then create a new Surface Milling Feature. 
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2 Select Finish. 

3 Please select the Centre point of the radial toolpath by snapping onto the 

cylinder centre point of the radial feature on the solid model. 

 

4 Change the Stepover Angle to 0.25 degrees. See a small section of the 

toolpath result shown below. Change the Leadin/out to the same as previous 

settings. 

 

 

 



              
 

   5.0 - Roughing & Finishing Strategies         

 

                                                                                                                                      
                                                                                                              

 Autodesk FeatureCAM 2017   

3.24                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

Flowline 

 The Flowline technique projects the Isolines from one surface onto the 

surfaces of the feature. The Isolines are projected in the direction of the 

surface normal.   

 

5 Create an arc at the Feature centre for example radius 40mm. Create a 

vertical geometry line so we can use this for surface of revolution. 

6 Select the shade Surfaces Icon  and toggle this so the solid model is 

transparent and all you will be able to see is the outline of the solid model. 

7 Hide the Stock. 

8 Zoom into the above feature.  

9 Select the Front View. 

 

10 Draw a 2Pt line between these two points as shown above. You may have to 

orientate the model slightly to snap to the points. Select Front view again. 

11 Select the line and change the length to 50mm. Select Modify to action the 

change. 



 
 
Roughing & Finishing Strategies 

                           

 

      
Autodesk FeatureCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           3.25 

12 Select the Line and then right click and select Transform. Move the line 

10mm in Z only.  

 

13 Select OK to action the command. 

14 Hide the solid model to make things clearer. 

15 Offset the line you have just created by 40mm to the right  

16 Then draw a line at the top of the two vertical lines  

17 Offset this line 10mm down  

 The image should look like one shown below. 
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18 Draw a circle with a radius of 40mm and snap the centre to point  

19 Then clip the circle so it looks like the image below. 

 

20 Create a Curve using Pick Pieces. 

21 Select the line working from top to bottom. 
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22 Create a Surface of Revolution using the vertical line as a rotation point. 

23 Select Construct>Surface>From Curves>Surface of Revolution 
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24 Create a Surface as shown. This will be used to project the toolpath onto the 

selected feature. Rename the surface and call this Flowline Surface. 

25 Select the features you want to machine. 

 

26 Create a new Surface Milling Feature. Select Flowline. 



 
 
Roughing & Finishing Strategies 

                           

 

      
Autodesk FeatureCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           3.29 

 

27 Select Finish. 

28 Rename Feature to Flowline. 

29 Double click on Flowline in PartView. 

30 Navigate to Surface Control and pick the Flowline surface as shown. 

 



              
 

   5.0 - Roughing & Finishing Strategies         

 

                                                                                                                                      
                                                                                                              

 Autodesk FeatureCAM 2017   

3.30                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

31 Under Milling change the stepdown to 0.5mm 

32 See finished Toolpath below. 

 

Between 2 Curves 

 Between two curves calculates toolpaths that are bounded by two 

curves. This finishing operation is used to control the shape of the 

toolpath over multiple surfaces by restricting the machining of the 

surface to be between the two specified curves. The toolpaths mill a 

feature in a series of offsets starting from the first or start curve 

towards the second or end curve. 

1 Create two curves using surface edges. 

2 Select the following option as shown on the next page. 

3 Then create curves from the edges shown. 
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4 Once you have created your curves make sure that the directions of both 

curves are running in the same direction. See example of curve direction 

below. Reverse if necessary. 

 

5 Create a new Surface Milling Feature 
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6 Select Surfaces on model. 
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7 Select Next. Pick the two curves as shown. 

 

8 Finished Toolpath. 
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Specialized Strategies 

Horizontal + Vertical 

 

 This strategy combines two different toolpath operations, one for 

finishing shallow portions of the part and one for finishing the steep 

regions. An X parallel or spiral toolpath is applied to the shallow 

regions, and a Z level finishing operation cuts the steep regions. 

 We have a problem with this model. The tool will go down the hole 

when machining. To prevent this from happening we need to create 

a Curve and then create a surface to cover the hole or what’s known 

as a capped surface. 

  

 

1 Create a Curve using Create a Curve from Surface - Surface edges. Pick the 

edge shown. 
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2 Now cap the surface using the curve you have just created. 

 

 

3 Select the curve as shown on the next page this will then create a surface that 

will cover the hole. Make sure that this surface is also selected when 

machining this part. 
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 Do the same for the smaller hole. This will prevent the tool from 

diving down into the hole when we apply our machining strategy. 

 

4 We will now create a Horizontal + Vertical machining strategy. 

5 Create a new Feature Ctrl+R  

6 Select Surface Milling and then select Next. 

7 Select the Part Surfaces by windowing over the selected surfaces. 

8 Select all the surfaces shown below. You may have to select the bottom 

surface as a check surface to prevent the toolpaths from going below the 

surface. 
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9 Please select. Choose a single operation. Select Next. 

 

10 Then select the Horizontal + Vertical machining strategy. Select Next and 

then select the following options. 
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11 Select Finish for the default tools and settings. Now select Check surfaces 

and select the surface shown on the second image. 
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12 Select Ok and Apply. 

13 Remember to rename the strategy to horizontal + vertical. The results of 

the toolpath are shown below. 

 

 A suggested tip would be to make the toolpaths more efficient by 

changing the Rapids to Relative retract. To select this double click 

on the Surface milling properties, then select the milling tab and then 

select Retract/Plunge. Select the following options. The image 

above shows the results of changing this option making the toolpath 

more efficient. 
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 Relative retract - When you retract and rapid to a new position, 

using the Relative retract option, the tool only retracts as high as 

it needs to go plus the Clearance amount that you enter. 

 This concludes the use of this Model 

Corner Remachining 

 We will start by importing a solid model in Parasolid format into 

FeatureCAM You will find this in the FeatureCAM training folder 

C:\Training_Data\FeatureCAM Course Data 2017\3D Machining\ 

All Strategies Part-2. x_t 
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1 Create a Stock boundary to make sure you machine the complete part. The pink 

solid model shown above is larger than the block it is supported on. Make the 

height just above the bottom surface of the four models. Select a Z Level 

Roughing strategy to rough out our part. Use a 50mm Facemill to rough the 

part out with a Z Level step down of 3mm. 
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Corner Remachining 

 Corner Remachining is used to clean up corners that occur between 

non-tangential surfaces. Each corner edge is called a trace line. By 

using the options on the strategy page, you may cut in various 

directions relative to the trace lines. 

 

 Corner Remachining is available in four different styles: Multi pencil, 

Along, Across, Combo along and across, with remove deep cuts as an 

option. 

 Remachining is used to automatically mill regions that were not cut by 

previous operations. You provide the diameter of the previous tool that was 

used to cut the part and FeatureCAM automatically determines the uncut 

regions and applies a toolpath to them. 

 Corner remachining is used to clean up corners that occur between non-

tangential surfaces. Each corner edge is called a trace line. By using the 

options on the strategy page, you may cut in various directions relative to 

the trace lines. 

 Remember to select the surfaces you want to machine.  

 Select Finish, and then access the Remachining Tab and input the 50mm 

Facemill. 
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 Multi Pencil - creates a corner toolpath which follows 'along' the 

trace lines. This is basically a different ordering of the along tool 

path. 
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 To achieve the results shown above the following parameters have 

been changed. 
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 Along - This style of Remachining creates a corner toolpath which 

follows the trace lines. 
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 Across - Remachining creates corner toolpaths that zigzag across 

the trace lines. 
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 Combo Along and across - The combo corner toolpath creates a 

corner toolpath which produces across toolpaths on the steep areas 

of the trace line and along toolpaths on the shallow areas of the trace 

line. 

 Remove deep cuts - removes segments of the toolpath where the 

depth of cut is too large, to prevent tool damage. 
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Steep and Shallow + Pencil 

 Steep and Shallow: - This strategy calculates a shallow boundary, 

and then creates a Z-level toolpath in the steep areas of the model 

and a Parallel or 3D Spiral toolpath in the shallow areas. 

 Pencil: - This strategy creates a single trace corner toolpath. It is 

used to clean up corners that occur between non-tangential surfaces. 

They are automatically calculated inside any existing boundary. 

Applications of pencil milling include: 

 Finishing fillets in a part with a single toolpath.  

 Cleaning up sharp concave corners.  

 Pre-relieving corners before high-speed finishing the part with a small tool.  

 Roughing fillets by using the Finish allowance. 

 Both Steep and Shallow + Pencil strategies can be added 

together in the Process tab using the same selected surfaces and 

Check surfaces. 

1 Please select the following surfaces. I have used the side surfaces as check 

surfaces to prevent the cutter from diving down the side walls. 

 

2 Create a New Surface Milling Feature. Select Ctrl+R to create a new feature. 

Use a 10mm Ballend tool. Change the Stepover for Steep and Shallow to 

0.5mm. Change the retract to Relative retract. 
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3 We can now add to the same process a Pencil strategy. Select the Add new 

operation Icon as shown below. 
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4 Select Next.  
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5 We need to activate the Remachining tab to let FeatureCAM know the size 

of the previous tool used. This is a 10mm Ball Nose tool. 

 

6 Select Finish. 
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7 Change to Relative retract under the Finish2>Milling tab. 
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Swarf 

 Swarf cutting calculates toolpaths that cut with the side of the tool 

and works only on developable surfaces because the tool needs to be 

in contact with the surface for the whole cutting depth. 

1 Select the following model. Select Hide>Hide Unselected. 
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2 Please select the magenta outside surfaces. Then create a New Swarf Feature. 

 

3 Please select Finish. Change the Leads to the following. 
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Steep and Shallow with Collision and Rest Machining 

 Steep and Shallow: - This strategy calculates a shallow boundary, 

and then creates a Z-level toolpath in the steep areas of the model 

and a Parallel or 3D Spiral toolpath in the shallow areas. 

 We will now machine the left hand solid model. You will see the area 

that needs to be machined, this is Yellow. The check surface is blue. 

1 Create a new Feature Ctrl+R. Surface Milling. 
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2 Select Next. 

 We are going to select the yellow surfaces. We can now select these 

by colour from the Edit menu. 

 

 

3 Please select this option. See next page for the selection options available. 

 

4 Select Colour and select Yellow from the colour drop down menu. 

5 Select Ok to select. Then select the green + key to enter the selection. 

6 Select Next and then select Choose a Single Operation. 

7 Select Next and choose Steep and Shallow. Select Next. 

8 Please select the following options. (See menu) 
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9 Select Finish. FeatureCAM should select a small short reach 12mm Ballend 

tool to finish the selected surfaces. We are not interested in the surface finish 

in this instance. This is to show you the tool gouging the part. 

 

 We have a number of options to avoid this.  

 1 – Use a longer tool. 

 2 – Use Holder collision clipping. See menu below. 
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10 Copy File in PartView. Then paste the file. Rename the first Surface 

machining operation. Steep and Shallow – original. Then rename the copy 

and call this Steep and shallow – Holder collision clipping. 

11 Edit the copy and select the option shown above. Run a 3D Simulation. 
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12 You can see that FeatureCAM has modified the toolpath to allow for the short 

tool. 

13 We will now create a Stock model of the toolpath just created. We can then 

just machine away the material that is left. This is known as rest machining. 

14 Select View>Simulation>Save simulation results. This will create a .Stl 

file of the machine area we have just machined. 

15 Call the file Steep and Shallow clipping.stl 

16 Save the file in Course work in the FeatureCAM directory. 

 

 

17 Import the .Stl file Steep and Shallow clipping.stl  

18 In PartView double click Stock Models and select Add. 

19 Select STL and select Steep and Shallow clipping. Name the Stock model as 

SSC. 
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20 Copy the previous toolpath and call this Steep and Shallow Rest 

Machining. 

21 Double click on the toolpath in PartView and change the following options on 

the next page. 
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22 Make sure you select a longer tool of the same diameter. If this does not exist 

please create one. Run a 3D Simulation to see the following results. 

 

 The next chapter covers boundaries for selective 3D machining.  
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Stepovers, Leads & Ramps 

Introduction 

 During roughing operations, FeatureCAM gives the user a very high 

level of control over the way that the tool initially engages the part 

and how it steps over between each pass on a z level. These 

connecting moves are controlled from within the Leads tab of the 

roughing feature. We will now look at the options available for 

stepping over between passes. 

Stepover types 

 When FeatureCAM clears a Z level it does so by means of a series 

of parallel passes, each separated from the next by the Rough pass 

stepover %. The way in which the passes are connected on a Z level 

is controlled by the Stepover type attribute on the Leads tab of the 

roughing feature. Stepover types that are available are Direct and 

Arc. By default the stepover type will be direct. 

1 Open the part Primary_Case_Pocket_Leads.fm 

2 Run a Centreline Simulation. 

3 In the Operation List click on the pull-down next to rough1 – Z level. 

4 Select the first Z level. 

5 Hide all features and select a Top view. 

 

 By default FeatureCAM makes a direct straight-line move from the 

end of one pass to the beginning of the next. This can lead to sudden 

changes in direction which may be undesirable, particularly during 

high speed machining. 
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 We will now change the stepover type from Direct to Arc. In an Arc 

stepover the tool makes a smooth circular arc move off one pass and 

then leads into the next pass with a second circular arc. This 

minimizes the rate of change in direction of the tool, and also reduces 

the changing of the tool load as it leaves one pass and engages the 

next. 

6 Eject the simulation. 

7 Edit the feature srf_mill1 and click on rough1. 

8 Select the Leads tab. 

9 Change the Stepover type to Arc. Apply and OK. 

 

10 Run a Centreline Simulation. 

11 In the Operation List click on the pull-down next to rough1 – Z level. 

12 Select the first z level. 

13 Hide all features and select a Top view. 
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 The passes are now connected by a smooth S-shaped arc leading off 

from one pass and onto the next. This allows the machine to be run 

at a higher speed and minimizes shock loading on the tool, thus 

reducing chipping and wear. 

Ramping moves 

When FeatureCAM roughs out a pocket, by default, all approach moves to the 

part will be ramps. That is, instead of plunging the tool directly into the material 

the approach will be made by a series of zigzag moves which progressively 

move the tool down into the material. We will now examine how these ramping 

moves may be controlled. 

Ramp angle and Maximum ramp distance 

The two attributes that control linear (straight line) ramping are the Ramp 

angle and the Maximum ramp distance.  

The Ramp angle controls the angle at which the tool approaches the part while 

moving downwards to the roughing z level. By default this is 5 degrees. In 

practice the angle that can be used will depend upon the type of tool being used 

and the material. For example with a centre cutting tool it may not be necessary 

to ramp at all whereas an insert cutter may require a shallow ramp angle.  

The Maximum ramp distance controls the length of the Zigs and Zags in the 

ramp. If no value is explicitly set by the user then FeatureCAM will base the 

maximum ramp distance on the tool diameter. The user can also choose to 

enter a value based upon the cutter geometry so as to prevent build-up of swarf 

below the tool centre. 
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 The diagram above shows a side view of a toolpath ramping into a 

part. 

 

14 Run a Centreline Simulation. 

15 Click on the pulldown next to rough1 in the operation list. 

16 In PartView Hide the Solid Part and change the simulation to Show Centreline  

17 Change to Front view or Ctrl + 2. 

 

 The tool approaches the material by making a series of zigzag moves 

at the default angle of five degrees to the horizontal plane. Form 

simulation purposes I have changed the Maximum Ramp Distance to 

25mm.  

18 Eject the simulation. 

19 Edit the feature srf_mill1 and click on rough1. 

20 Select the Leads tab. 

21 Set the Ramp angle to 15 degrees. 

22 Run a Centreline simulation. Apply and OK. 

23 Click on the pull-down next to rough1 in the operation list. 

24 Select the first roughing level. 



              
 

                                 Leads and Ramps        

 

                                                                                                                                      
                                                                                                              

 Autodesk FeatureCAM 2017   

4.6                                                                                                                  © Copyright 2016 Autodesk, Inc. All rights reserved 

 

 The tool is now approaching the material at a steeper angle and 

making fewer moves on the way down. Approach moves are made at 

a slower feedrate than normal cutting moves, typically 50% slower. 

This means that the amount of time spent ramping can end up being 

a significant proportion of the overall machining time. By increasing 

the ramp angle we are reducing the total distance travelled in the 

approach moves and thus reducing the time taken to machine the 

part. 

25 Eject the simulation. 

26 Edit the feature srf_mill1 and click on rough1. 

27 Select the Milling tab. 

28 Set the Max. Ramp distance to 50mm 

29 Click Apply and OK. 

30 Run a Centreline simulation. 

31 Click on the pull-down next to rough1 in the operation list. 

32 Select the First roughing level. 

 Note how the length of the ramping moves has increased from the 

default of the tool diameter to 50mm. 

33 Click on the pull-down next to rough1 in the operation list. 

34 Select the roughing level near Z -21.324. 

 At this lower level the size of the part is smaller and consists of two 

separate pocket areas. FeatureCAM uses the specified ramp 

distance wherever possible. In the smaller round pocket area it is not 

possible to fit in a ramp with the specified length of 50mm so 

FeatureCAM automatically switches to using a helical ramp.  

It is possible to force FeatureCAM to use a Helical ramp in all cases: 
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Straight Ramp 

 

Helical Ramp 

 

35 Eject the Simulation. 

36 Edit the feature srf_mill1 and click on rough1. 

37 Select the Leads tab. 

38 Check the Helical check box below the Ramp to depth wording.  

39 Apply and OK. 

40 Run a Centreline simulation. 

 All of the ramping moves are now helical. It should be noted that the 

Maximum ramp distance also applies to helical ramping moves. 

Rather than defining the length of the move before the direction is 

changed for a helical ramp the distance defines the diameter of the 

helix. 

41 Eject the simulation. 

42 Edit the feature srf_mill1 and click on rough1. 

43 Select the Milling tab. 

44 Change the Max. Ramp distance to 6mm. Apply and OK. 

45 Run a Centreline simulation. 

 Note how the diameter of the helical ramp is reduced. 
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Plunging to Pre-drilled holes 

 If a roughing cutter does not centre cut ramping moves can be used 

to allow the cutter to engage the material without causing damage to 

either the cutter or the part. The main disadvantage of ramps is that 

the cutter is moving at a reduced feedrate and making unproductive 

moves. Where a part has many roughing levels and a shallow ramp 

angle used the ramps can become a significant proportion of the 

overall cutting time. It is often more efficient to use a pre-drilling 

operation to provide a location where the roughing tool can plunge 

into free space and then engage the material in a horizontal cutting 

move. 

46 Eject the simulation. 

47 Edit the feature srf_mill1 and click on rough1. 

48 Select the Leads tab. 

49 Check Plunge to pre-drill location. 

50 Set the Drill diameter to 16mm. Apply and OK. 

51 It is also possible to add a Spot drill operation if required, in this case we will 

not. 

52 Use Play to next rapid in a 3D Simulation. 

 The tool plunges into the centre of the pre-drilled holes. The 

locations of the holes are automatically calculated to lie at the 

lowest point of each enclosed area of the part. 
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Roughing Flat Areas 

Introduction 
 

 The area clearance strategies in FeatureMILL3D have an option that allows the 

user to control the way in which flat areas of the model are rough machined. 

There are cases in which the user will want to ignore flat areas leaving extra 

material in the vertical direction on those areas. Usually it is necessary to remove 

material from the horizontal areas to leave the same amount of stock there as 

on the rest of the part. 

 

1 Open the file Flats.fm. 

2 Select an Isometric view. Shade the part if necessary. 

 

 

 This model contains several horizontal flat areas. If these areas are not 

machined there may be an excess of stock remaining for the semi-finishing 

process to work well. We will now look at how to control the machining of flats. 

3 Click on Features in the Step view. 

4 Check Surface Milling and press Next.  

5 Box select all of the surfaces and then press the Add from selected items 

button  then click next. 

6 On the New Strategy dialog check Choose a single operation. 

7 Click Next. 
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8 Check Z Level in the Roughing Strategies part of the dialog. 

9 Press Finish. 

10 Edit the feature. 

11 Click on rough1 in the tree view. 

12 Select the Milling tab. 

 Fill in the form exactly as shown below, setting Flat surface 

support to Off and setting the Z increment to 12mm. 

 

13 Press Apply and OK. 

14 Click Manufacturing on the main menu. 

15 Choose Post Process. 

16 Set the Tool change location Z to be 100mm. Click OK. 

17 Run a Centerline simulation. 

 

 As flat surface support is turned off, FeatureMILL3D has ignored all of the Flat 

Surfaces and cut only at the specified Z levels (every 12mm down from the 

top of the stock). 
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 It can be seen that a lot of stock remains in the areas indicated. This 

could cause problems for subsequent operations. We will now look at 

the alternatives. 

 

18 Edit the feature. 

19 Click on rough 1 in the tree view. 

20 Select the Milling tab. 

21 Change Flat surface support to Level. 

22 Click Apply and OK. 

23 Run a Centerline simulation. 

24 Select a view from the Left. 
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 Three extra roughing levels have been added. These are offset from the flat 

surfaces by the Finish Allowance plus the Rough Tolerance. The levels extend all 

the way to the edge of the block thus increasing the machining time. If a part 

has many flats the machining time may become very long.  

 

25 Select an Isometric view. 

26 Run a 3D Simulation to see how the flat levels are cleared all the way to the 

edge of the stock. 

 We will now look at the most efficient way of machining the flat 

areas on the part. 

 

27 Edit the feature. 

28 Click on rough 1 in the tree view. 

29 Select the Milling tab. 

30 Change Flat surface support to Area. 

31 Click Apply and OK. 

32 Run a Centerline simulation. 

33 Select a view from the Left. 
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 Note how the flat area clearance now only extends to the edge of each 

flat area. This eliminates unnecessary tool moves and will result in a 

shorter, more efficient tool path. 

  

34 Select an Isometric view. 

35 Run a 3D Simulation to see how the flat levels are cleared only in the 

required areas. 

36 To add an extra tool to the process to remove material left by the 12mm 

cutter we can add a tool under the Remachining tab in Z-Level.  

37 Select the Remachining tab and then select Multiple tool diameters and add 

12,8 into the field as shown on the next page. 

 

 

 

 

 



 
Roughing Flat Areas 

                           

 

      
Autodesk FeatureCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           5.7 

 

 

 Remember to change both cutters to Area under the milling tab and change 

the Z Increment to 12mm for the 8mm cutter. The following image shows the 

8mm tool machining the area that was left by the 12mm cutter. 
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High Speed and High Efficiency Roughing  

Introduction 

The aim of the roughing process is to remove as much material from the part in the 

shortest possible time. There are three main approaches to do this, High Efficiency 

roughing, High Speed roughing and Plunge roughing. 

In high efficiency roughing special tooling is used to take very heavy cuts. This removes 

the maximum possible amount of material per pass. Due to the heavy cuts it is 

important to maintain a steady load on the tool. FeatureCAM uses the trochoidal 

milling method in areas where a tool overload condition would occur. Trochoidal milling 

moves the tool into the material in a series of loops whenever a potential overload is 

detected. 

In high speed roughing a relatively light cut is taken but the cutting speed is made as 

fast as possible. While it is possible to output NC code with very high feed rates, in 

practice such a program would probably not run at the programmed speed on a 

machine tool. The controller slows down the feedrate each time a sharp change of 

direction is detected. The accelerations and decelerations involved can result in a 

program taking much longer to run than expected. To program a true high speed 

program it is important to minimize changes in direction and make the transitions 

between directions as smooth as possible. FeatureCAM’s trochoidal milling and 

patented raceline machining processes are ideally suited to high speed roughing. 

Plunge roughing roughs a part by a series of drilling moves using a large cutter. 

Specialized tooling is required. As the machine is only moving in Z it is more rigid and 

hence more aggressive feeds can be used. Plunge roughing is particularly suited to 

deep pockets. With conventional cutting the feed rate has to be reduced the longer the 

tool gets. With plunging the same feedrate applies all the way down the pocket. Plunge 

roughing is covered in a separate document. 

High Speed Roughing 

1 Import the file Fast_Rough.x_t. 

2 Create Stock and Setup 

3 Box select all the surfaces. 

4 Create a Z Level roughing feature. Use Offset/Spiral in the Strategy. 

5 Click Finish. 

6 Click on rough1 and select the Milling tab. 

7 Change the Rough pass stepover % to 15%. Apply and OK. 

8 Run a Centreline simulation. 

9 In the Operations List, click on the down arrow next to the roughing 

operation and select the second roughing level. 

10 Select a top view. 
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 This has created a Z Level roughing operation with the default 

settings. Note the sudden changes in direction; this path is not 

suitable for high speed machining. We will now modify so that it can 

be run at high speed. 

11 Eject the simulation  

12 Select the Milling tab and change the Toolpath corner % to 50. 

13 Click Apply, then Preview and then Play selected  

14 In the operations list click on the down arrow next to the roughing operation 

and select the second roughing level. 

 

 Note how the toolpath now has radii where it changes direction also 

the way that the paths are smoothed as they get further from the 

profile. This path has some cuts which engage a large part of the 

cutter diameter however as we are going to use a small depth of cut 

this is not important. Although the cutting portion of the toolpath now 

is much smoother the Stepovers still make sudden changes of 

direction. We will now change this. 

15 Eject the simulation  

16 Double click on the feature to open its properties. 

17 Select the Leads tab and change the Stepover Type to Arc. 

18 Select the Milling Tab. 
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19 Set the Z increment to 1mm and Rough pass stepover to 10%. 

20 Run a Centreline simulation. 

21 In the operations list click on the down arrow next to the roughing operation 

and select the roughing level at Z -2.040 or thereabouts. 

 

 Note: the links now make a smooth arc between the toolpath 

segments. 

22 Select an Isometric view and run a 3D simulation. 

 

 The material is roughed out in a series of shallow steps with a small 

stepover. The smooth shape of the toolpath and the small amount of 

material being removed per pass means that the cutter can run much 

faster giving an overall high rate of metal removal. 

23 Eject the simulation  
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High Efficiency Roughing 

 We will now take a look at high efficiency roughing where a large 

tool will be used with a deep cut and small stepover to increase the 

metal removal rate. 

24 Double click on the feature to open its properties. 

25 Select the milling tab and fill in exactly as below. 

 

26 Single step a 3d simulation. 
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 The initial moves into the material are taking a very heavy full width 

cut. This overload situation may cause damage to the tool and would 

require a reduced feedrate. We will now use Trochoidal roughing to 

reduce the tool loading. 

Limiting tool overload 

 When roughing a part which has narrow slots, when entering a sharp corner or 

on the first pass in a pocket it is desirable to avoid overloading the tool. It is 

possible to do this by using trochoidal machining. This strategy detects when 

tool overload is likely and changes from normal machining to a toolpath which 

enters the overload area in a series of loops as shown below. This greatly 

reduces the tool loading and allows the toolpath to be run at a higher feedrate 

without damaging the tool. 

 

27 Eject the 3d simulation. 

28 Edit the feature and select the Milling tab. 

29 Check Trochoidal cut and set Avoid overload to 25%. 

 This is telling FeatureCAM that when the tool engagement reaches 

25% of the tool diameter the cutting strategy should be switched to 

Trochoidal. 
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30 Click Apply and then OK. 

31 Run a Centreline simulation. 

32 Take a Top view. 
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 It can be seen that the toolpath has changed so that the tool overload 

situation is avoided by changing to Trochoidal moves. The tool loading 

is significantly reduced but the overall toolpath length is increased, 

this will mean that the roughing process will take longer to complete. 

This can be fixed by using FeatureCAM’s Feedrate Optimization 

capability. We will see how to do this at the end of this module. 

33 Run a 3D Simulation. 

 

 The bulk of the material is removed quickly but the remaining stock 

has large steps. Due to the large tool diameter a lot of material is left 

on the inside corners. A second roughing pass will be added to reduce 

the steps and remove more material from the corners. 

34 Double click on the feature to open its properties. 

35 Select Z level and fill in the form as below. 
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36 Click Apply. 

37 Select the second roughing operation and set its Z increment to 1.25mm. 

38 Run a 3D Simulation. 
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 The material is quickly roughed out by the large tool; the steps and 

excess inside corner material are then reduced by the smaller tool 

in the second roughing operation. 

Feedrate Optimization 

 In the previous example trochoidal roughing was used to reduce the loading on 

the tool when first engaging the part and in confined areas. While this technique 

reduces the tool loading it also increases the overall length of the toolpath. 

Fortunately FeatureCAM has the ability to vary the feedrate on each block of 

NC code within a toolpath. The rate can be increased or decreased depending 

upon the actual amount of material being removed by the tool and a target 

horsepower which the user sets for each operation. 

39 Run the simulation and then click on the NC Code tab. 

 Just two machining feed rates are being used within this, program, 

the plunging feedrate and the cutting feedrate. 

We will now instruct FeatureCAM to calculate the feedrate such 

that it maintains an optimum loading on the tool, where the cut is 

lighter the tool will move faster, where the cut is heavy it will slow 

down. 

40 Edit the feature and select the Milling tab for the first roughing operation. 

41 Set the Target horsepower to 0.2 HP. 

42 Click Apply and OK. 

 Given the required tool loading (0.2 HP) FeatureCAM can then look 

at the spindle speed, number of flutes on the tool and the material 

properties and calculate the required feedrate to maintain the load 

on the tool. 

43 From the Manufacturing menu select Feed optimization. 

Fill in the form as shown on the next page. 



 
High Speed & High Efficiency Roughing 

                           

 

      
Autodesk FeatureCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           6.11 

 

 

 The first item is telling FeatureCAM that if the load is less than 90% of 

that specified (0.2 Hp) then the feedrate should be increased until the 

calculated load is as required. 

 The second item limits the feedrate so that if the cut is extremely light the 

feedrate does not go more than four times the originally programmed rate. 



              
 

  High Speed & High Efficiency Roughing       

 

                                                                                                                                      
                                                                                                              

 Autodesk FeatureCAM 2017   

6.12                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

 The third item is limiting the overload on the tool by setting an upper limit 

for the horsepower, in this case 110% or 0.22HP. 

The fourth item sets a lower limit on the feedrate so that the tool does not 

move at an unreasonably slow speed when encountering heavy cutting 

conditions. 

  

The other items are fairly self-explanatory, for further information 

please see the help file. 

 

44 Click OK. 

 FeatureCAM now recalculates the toolpath. For each move it calculates the 

feedrate required to maintain the spindle loading within the limits specified 

above. The resulting NC code is shown below 

 It can be seen that the feedrate is now varying. As the Trochoidal toolpath 

is reducing the loading the feed rates are being increased. This will result 

in the toolpath running in a shorter time on the machine.  

The more constant loading will also reduce rubbing in areas where the cut 

is light and prevent overloading in heavy cut areas. This will increase the 

tool life and give a better surface finish. 
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Corner & Pencil Finishing  

Introduction 

 Corner Machining includes 5 different types of strategy:  Pencil, Multi Pencil, 

Along, Across and Combo Along and across. Pencil milling creates “single pass” 

machining along sharp internal corners while corner machining performs local 

re-machining of areas inaccessible to a larger tool. 

1 Open the file Cowling.FM 

2 Select an Isometric view 

 This model contains a number of sharp inside corners. During this module we 

will see how to finish these with a smooth radius without having to model the 

radii into the part. On large complex models using the machining process to 

produce the radii on the model can give very significant reductions in the time 

taken for the designer to produce the model. 

By using a large tool to finish the bulk of the part and then picking out the 

corners later with a smaller tool, we can also make significant time savings in 

the finishing process. 

3  Run a 3D Rapid Cut simulation 

 

 The part has been roughed out and then finished using a 20mm ball nosed 

cutter. This has been done so that a large finishing stepover can be used to 

finish the majority of the areas while still leaving enough material in the corners 

to produce 3mm fillet radii in the sharp corners on the model at the end of the 

machining process.  

Pencil Finishing 

This operation produces single pass tool tracks along the intersection between 

sharp internal corners of the component surface. We will now create a pencil 

milling feature with the default values. 

4 Eject the simulation 

5 Uncheck the operation srf_mill1 in the part view 

6 Select all of the part surfaces 
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7 Create a new Surface milling operation 

8 Click Choose a single operation and click Next 

9 Select Pencil strategy and click Finish 

10 Edit the feature 

11 Click on Finish1 in the tree view 

12 Select the Tools tab and pick a 6mm ball endmill 

13 Click Apply and then OK 

14 Unshade the part 

15 Run a Centreline simulation 

 

 The tool is making a single pass around the entire inside corners on 

the part. Both Corner Finishing and Pencil Milling strategies allow 

slope limits to be specified on the Slopes tab of the operation.   

Horizontal only limits the cutting to regions with a slope less than 

the user defined maximum surface slope. 

Vertical only limits the cutting to steep regions with a slope greater 

than user defined minimum surface slope.  

 Limiting the regions where an operation is performed can solve the 

potential problems associated with the tool running up or down 

steep slopes. For instance the user could apply a stitch strategy to 

track across the steep areas and parallel strategy for shallow areas. 

Also a higher feed rate could be used on the shallow areas and a 

lower feed rate on the steep areas, which if applied first is more 

likely to be taking a heavy cut. 

16 Eject the simulation 

17 Edit the feature 

18 Click on Pencil in the tree view and click on the Slopes tab 

19 On the Slopes tab, Click Horizontal only 

20 Set the Maximum surface slope to 30 

21 Click Apply and then OK 
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 We are restricting the toolpath so that it only cuts those areas on the 

model where the surface normal is inclined at less than 30 degrees 

to the vertical. 

22 Run a Centreline simulation 

 

 The toolpath is now only cutting the shallow areas of the model and 

avoiding the steep areas. 

23 Eject the simulation 

24 Edit the feature 

25 Click on Pencil in the tree view and click on the Slopes tab 

26 Click Vertical only and then set the Minimum surface slope to 30 degrees. 

27 Click Apply and then OK 

28 Run a Centreline simulation 
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 The toolpath is now only cutting the steep areas of the model and 

avoiding the shallow areas. 

Corner Finishing 

All the Corner Finishing strategies, (except for Pencil) are corner re-machining 

techniques.  

In the illustration below a 60mm diameter tool would have left material in the 

corner between the points marked (2). The 30mm diameter corner finishing 

tool needs to remove the extra material between the points (1) and (2) on each 

side of the corner. 

 

29 Check the surface milling feature named srf_mill1 in the Part View 

30 Edit the pencil milling feature 

31 On the Slopes tab set Slope limitations to None 

32 Click Apply and then OK 

33 Run a 3D Rapid Cut simulation 
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 You can clearly see in the inside corners that there is material 

remaining between the areas finished by the 20mm cutter and the 

6mm tool used in the pencil operation. 

 Eject the simulation 

34 Uncheck srf_mill1 and srf_mill2 in the Parts view 

35 Select all of the part surfaces 

36 Create a new Surface milling operation 

37 Click Choose a single operation and click Next 

38 On the New strategy tab select Corner Remachining 

39 Click Next 

40 Select Along and set the Previous tool diameter to 20mm 

 The Overcut Percent figure defines the overlap of the Remachining 

operation over the original finishing operation. By default this is 5% 

which will overlap the two toolpaths sufficiently to eliminate any 

witness marks where the toolpaths meet. 

41 Click Finish  

42 Edit the feature.  Click on Remachining in the tree view 

43 On the Slopes tab, Click Horizontal only and set the Maximum surface slope to 
30 

44 Click on finish1 in the tree view 

45 Click on the Tools tab and select a 6mm ball endmill 

46 Click Apply and then OK 

47 Run a Centreline simulation 
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 The shallow areas are being cleared of excess material from the 

outside inwards in a climb milling direction. There are multiple lift offs 

resulting in a lot of “air time”. The tool is also plunging directly into 

the remaining material. We can remedy both of these problems by 

modifying the leads and links. 

48 Eject the simulation and Edit the feature 

49 Click on Finish1 in the tree view and click on the Leads tab 

50 Fill in the form exactly as shown 

 

51 Click Apply and then OK 

52 Run a Centreline simulation 
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 The tool is now arcing on and off the part smoothly. Short links are 

joined by loops. Longer links are still lifting off the job. We will now 

reduce the amount of time spent in the air by switching to Relative 

Plunge/Retract.  

53  Eject the simulation and Edit the feature 

54 Click on Finish1 in the tree view and click on the Milling tab 

55 Note: The surface finish is controlled by the scallop height value 

56 Click on Retract/Plunge 

57 Fill in the form exactly as shown and click OK 

 

58 Click Apply and then OK 

59 Run a Centreline simulation 
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 Relative plunge tells FeatureCAM that you wish to plunge at rapid 

down to the specified Plunge clearance above the next point to be cut 

rather than plunging at a reduced feedrate all the way from the Z 

rapid plane. This reduces the length of time spent on slow plunge 

moves. 

Relative retract instruct FeatureCAM to retract by only enough to 

maintain the specified clearance from the part when moving at rapid 

from one toolpath pass to the next. Another name for this is 

Skimming as the tool skims above any obstacles rather than 

retracting all the way to the z rapid plane. 

Corner across Finishing 

 Along finishing works well on shallow areas of a part, however, where a corner 

runs down a steep area the strategy is less suitable as it will either be machining 

down the corner or when cutting it will be bringing the tool sideways into the 

remaining material at the bottom of the pass. In such cases it is better to use a 

Corner across strategy where the tool clears the remaining material by beginning 

at the top of the steep area and “stitches” to and fro across the corner. The tool 

loading is thus reduced giving a good surface finish with a smaller risk of tool 

damage. 

1 Eject the simulation 

2 Edit the srf_mill3 feature 

3 Click on Remachining in the part view and select Across as the Option 

4 Click on Slopes tab and Select Vertical only and enter a Minimum surface slope 

of 30 

5 On the Stock tab change the Overcut % to Zero 

6 Click Apply and then OK 

7 Run a Centreline simulation 
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 The tool stitches across the corner in such a way that each pass 

follows the surface normals of the intersecting surfaces at the point 

of contact of the tool. On a horizontal corner the place of the toolpath 

passes would be vertical; when the corner is vertical the toll will make 

passes in the horizontal plane. Note how the plane of the tool passes 

varies smoothly with the changing angle of the surfaces being 

machined. 

Combo Along and Across Corner Finishing 

 In the examples above we have seen how steep and shallow corners can be 

machined using Along and Across strategies respectively. By creating two 

operations and choosing appropriate slope angles we can machine all of the 

corners on a part. In order to make this easier FeatureCAM has another 

strategy which automatically combines the along and across strategies in a 

single toolpath. 

8 Eject the simulation 

9 Edit the srf_mill2 feature 

10 Click on Remachining 

11 On the Strategy tab select Combo Along and Across 

12 On the Slopes tab, Click None 

13 Click OK and simulate the toolpaths 
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 This has machined the shallow areas using an Along strategy and the 

steep areas using Across. This gives the optimum surface finish whilst 

protecting the tool in steep areas. The two parts of the toolpath meet 

exactly at the point where the slope angle changes from steep to 

shallow. Where the smoothness of the fillets are important it may be 

desirable to follow an Across or Combo toolpath with a Pencil 

operation to remove the scallops left where the tool has stitched 

across the corner. 

14 Turn on the features srf_mill1 and srf_mill2 in the part view 

15 Edit the feature srf_mill2 

16 On the Slopes tab select None 

17 Click Apply and then OK 

18 Reorder the toolpaths in the operation view so the pencil is last 

19 Run a 3D simulation 

 

20 Turn on Tool colours in the Simulations options - General tab 

21 Run a 3D simulation 

 

 You can now clearly see the area where the Remachining has 

removed the excess stock. 
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Corner Multi Pencil Finishing 

 Multi Pencil finishing is a variation on Corner Along machining. The main 

difference is that the toolpaths are ordered in such a way as to minimize the 

number of times the tool lifts off the job. Successive passes are joined by smooth 

looping moves. The toolpath is best suited to parts with shallow corner areas 

and materials/tooling where the cutting direction is not important as it is not 

possible to control the cutting direction. 

22 Eject the simulation 

23 Uncheck srf_mill1 and srf_mill2 in the Part view 

24 Edit the srf_mill3 feature 

25 Click on Remachining in the part view and select Multi pencil as the Option 

26 On the Slopes tab, Click Horizontal only and set the Maximum surface slope to 
30 

27 On the Stock tab set the Overcut % to 100 

28 Click Apply and then OK 

29 Run a Centreline simulation 

 

 This toolpath is similar to the Along strategy except that it doesn’t 

lift off the job as much.  The only disadvantage is that it alternates 

between climb and conventional milling. 
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4-Axis Rotary Finish Machining 

Overview 

 In 4th Axis or Rotary machining, a part is mounted in a rotary chuck which 

rotates to allow access to areas of the part not normally reachable by 3 axis 

machining. In this example, we will be finish machining a component which 

would be difficult to machine using a 3-axis setup due to its length and small 

inside radii. 

4-Axis Finishing 

1 Open a new Metric milling document. 

2 Fill in the stock Dimensions form as shown below 

 

3 Press Finish 

4 On the Stock properties form select the Indexing tab 

 We need to tell FeatureCAM which axis our machine will be using for 

rotational moves. In this case we are setting up to rotate around the X 

axis. In general, there are three possible rotary axes. These are called 

the A, B and C axes. A 4-Axis machine will have the normal X,Y and Z 

linear movement axes plus one rotary axis. Depending upon the 

machine, this may be an A axis (rotates around X), a B axis (rotates 

around Y)or a C axis (rotates around Z). The most common 4-Axis 

machine configuration is XYZ plus A axes. 

5 Fill in the form as shown below 
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 Here we have set up the stock to rotate about a rotary X or A axis. 

6 Press Apply and then OK 

7 Import the model Spindle.x_t 

8 Use the wizard to set the stock. Round and in the x axis. 

9 Use Compute stock from the size of the part. Allow 1mm for front, 

25mm back and 1mm OD. 

10 Have the Setup1 at the front. Select the right hand icon then select -1 Press 
Finish 

11 Select the Front view. It should look like the image shown on the next page. 

 

 The stock and component are aligned with the X axis. In the stock 

properties form we told FeatureMILL3D that we were going to use 4th 

Axis Positioning and were going to rotate around the X axis. We now 

need to create a surface milling feature. 
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12 Select all of the surfaces 

13 Create a new surface milling feature and Next 

14 Check Choose a single operation and press Next 

 As you will see there is now a new option on the New strategy form 

– Four Axis 

15 Check Four Axis Rotary and press Next 

 

16 Fill in the form as shown on the next page. 
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 The Y offset allows the tool to be offset away from the default Y zero 

position. This allows the user to prevent the tool from centre cutting. 

17 Press Finish 

18 Press OK 

19 From the main menu select Manufacturing then Post Process 

20 Set the Tool change location Z to 300mm 

21 Click on the Browse button and select the HaasVF-4axis post 

22 Press OK 

23 Run a Centreline simulation 
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 It can be seen that the toolpath is rolling over the ends of the part. 

We need to limit the extents of the toolpath to give the desired 

result. 

24 Eject the simulation 

25 Edit the feature 

26 Click on finish1 in the tree view 

27 Select the Milling tab 

28 Click on Index start coordinate and set the value to 0 

29 Click on Index end coordinate and set the value to 115mm 

30 Click Apply and then OK 

31 Run a centreline simulation 

 

 The toolpath is now limited to the portion of the feature between X 

0.0 and X-115mm. It is important to remember that the X values 

given are from the setup origin to the centre of the tool. It is also 

possible to apply an angular limit to the toolpath allowing the user to 

machine a selected area of the feature. 

32 Edit the feature 

33 Click on finish1 in the tree view 

34 Select the Milling tab 

35 Click on Angle start and set the value to 0 

36 Click on Angle end and set the value to 120 

37 Click Apply and then OK 
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38 Run a centreline simulation 

39 Select a view from the Left 

 

 It can be seen that only one third of the part has been machined. 

The start angle of 0 is aligned with the Z axis, and the end angle of 

120 is in the clockwise direction around the X axis. 

We will now look at the Circular and Spiral options of 4 axis 

machining. 

40 Edit the feature 

41 Click on finish1 in the tree view 

42 Select the Milling tab 

43 Click on Angle start and then Unset 

44 Click on Angle end and then Unset and Apply 

45 Click on four axis in the tree view 

46 Check the Circular option on the Strategy tab 

47 Click Apply and then OK 

48 Select an Isometric view 

49 Move the Simulation speed slider to the left to slow down the simulation 

50 Run a centreline simulation 
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 This time the toolpath runs around the part instead of along it. The 

direction of rotation reverses on each pass. The tool steps over on 

the surface of the part between passes.  

51 Edit the feature 

52 Click on four axis in the tree view 

53 Check the Spiral option on the Strategy tab 

54 Click Apply and then OK 

55 Select an Isometric view 

56 Run a centreline simulation 

 

 With the spiral option selected the toolpath follows a continuous spiral 

along the part. This will give a better surface finish than the circular 

option as there will be no dwell marks from stepover moves. The 

strategy will require a machine tool with a rotary axis which can 

rotate continually with no axis limit. We will now look at controlling 

the cutting direction. 

57 Edit the feature 

58 Click on finish1 in the tree view 

59 Select the Milling tab 

60 Click on Index start and set the value to 0.0mm 

61 Click on Index end and set the value to -115 

62 Click Apply and then OK 

63 Run a centreline simulation 
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It can be seen that the X direction of cutting has now been reversed. 

64 Edit the feature 

65 Click on four axis in the tree view 

66 Set the Y Offset to be 6mm 

67 Click Apply and then OK 

68 Edit the stock properties and change to a User defined stock 

69 Select solid1  

70 Select a Right view 

71 Run a 3D simulation 
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 It can be seen that the cutter is now offset from the rotary axis by 

6mm in the Y direction. This means that the tool is not centre cutting. 

This will create better cutting conditions giving improved surface 

finish and tool life. 
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     Steep & Shallow finishing with separate 

Shallow Step-over. 

Introduction 

 Both Optimised Constant Z and Steep and Shallow strategies have an option 

to apply a separate, larger Stepover across shallow areas. This option is 

designed to enable a more efficient machining of shallow areas with a Tip 

Radius tool. 

 The main advantage with the Steep and Shallow strategy is that the 

Threshold Angle is user defined. This can be set to 0 making the large stepover 

apply over flat areas only.  

 

1 Create a new Metric Document. 

2 Import Steep & Shallow. X_t Model into FeatureCAM. 

3 Go to File>Import. Browse to your instructors preferred location for 3D 

models. 

 

4 Untick Launch AFR after Finish. 

5 Select Next 4 times until you get to Stock dimensions. 

6 The model is already aligned. 

7 Enter the following Metric Stock dimensions. 
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8 Select Next to set the Pick Initial Setup XYZ Location Metric. 

9 Select the Centre +  button which will set the Z position to Zero. Then 

enter  -1 which will set the Setup position to the top of the solid model. 

 

10 Create a New Feature, Surface Machining. Select Ctrl+R to activate the New 

Feature Menu. 
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11 Select Next. 

 

12 Select only the Surfaces shown above. 

13 Select Next. 
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14 Select Choose a single operation. 

15 Select Next. Select Z Level. 

 

16 Select Next. 
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 The following menu will appear. 

 

17 Select Rough>Offset/Spiral>3D Boss. 

18 Select Finish. 

 This will Rough out our Steep and Shallow example. 

 

19 Change the Override Depth of cut on your tool, to change the depth of cut to 

a more suitable step down. 

20 In PartView select srf_mill1 by double clicking the Feature. 

21 The following menu will appear. 
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22 Please select Check Surfaces. 
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23 Pick the surfaces selected above. This will make sure that these surfaces are 

not machined. (Check Surfaces). 

24 Select OK to close the menu. 

25 Then select Process and then select the Add new operation icon. 

 

26 The following menu will appear. Select Steep and Shallow. 
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27  Select Next. The following menu will appear. 

 By default the Threshold angle defaults to 30.00 degrees. Set this 

to Zero. Then select Continuous spiral for Steep and Smoothing 

and Continuous spiral for Shallow. 

 

28 Select Finish accepting the default settings. 

29 By default FeatureCAM will select a 12mm Ballend tool. 

30 We need to change this to a Tip radius tool with a larger diameter and a small 

tip radius. For example 20mm R1. 
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31 Please select the Milling Tab in the same menu. The following menu will 

appear with default settings. 
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 We need to set the following parameters. Scallop stepover. Please 

select this option. This will remove the Steep stepover and replace 

this with Scallop Height=0.025 Change the Steep stepover = 8mm 

Then change the Check axial allowance to -8mm The image below 

shows a 3D Simulation using these values. 

 

 

 



              
 

                                   Steep and Shallow      

 

                                                                                                                                      
                                                                                                              

 Autodesk FeatureCAM 2017   

9.12                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

 Notice the larger step over on the flat surfaces.  

32 Save the file in your Instructors preferred location.  
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Vortex 3D 

 If you have previously covered the 2.5D Milling Course and Vortex, 

then the first three exercises may be skipped.  

 Vortex has been developed by Delcam specifically to gain the maximum 

benefit from solid carbide tooling, in particular those designs that can give 

deeper cuts by using the full flute length as the cutting surface. 

 It can be used for 2 and 3 axis roughing, positional five-axis area clearance 

and for rest machining based on stock models or reference toolpaths. 

 While Vortex will be an available strategy for 2.5 Axis features, a Feature 

RECOGNITION license will be required to utilize it. 

What is Vortex and how does this toolpath strategy work? 

 Vortex machining is an area clearance strategy that rapidly removes 

material from a 3D part while controlling tool load. Vortex is best suited to 

solid carbide tools and is frequently used in combination with step cutting 

(3D HSM license is required for Step Cutting). 

 Vortex is an offset-style toolpath and has these main features: 

 The engagement angle never exceeds more than 15%, which is produced 

by a straight line cut with a given stepover. This eliminates excessive tool 

load on all full-width cuts. This enables you to increase feed rates. For other 

area clearance toolpaths, the cutting values are based on the tool 

manufacturer's slot cutting parameters to ensure the tool can sustain full 

cutting engagement. As the tool approaches the maximum engagement 

angle for optimum machining, the toolpath changes to a trochoidal path to 

avoid tool overload. 

 The machine tool almost always runs at the specified feed rate. With other 

area clearance toolpaths, the machine tool automatically slows down as it 

approaches a corner and the engagement angle increases. Vortex modifies 

the toolpath so the tool engagement angle is never exceeded and the 

machine tool achieves the specified feed rate. The only time the machine 

tool doesn't run at the specified feed rate is when the model geometry (a 

slot or corner) is smaller than the smallest radius that the machine can run 

at full speed. 

 Vortex machining cuts with the side of the tool so it is designed for 

solid carbide tools, but you may be able to use other tools. Because 

FeatureCAM controls the tool engagement; you can increase the 

depth of cut, which minimizes machining time. Vortex machining is 

frequently used in combination with Step cutting to minimize 

terracing while maximizing the removal rate. 

 Vortex toolpaths are automatically checked for safety. FeatureCAM 

checks for: 

 Plunges into stock. 

 Excess tool engagement 

 Excess depth of cut 

 Small arc movements 
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 To maximize the benefits of Vortex machining: 

 Configure the Vortex parameters to suit each machine tool. 

 Use step cutting (3D HSM only) to minimize terracing caused by the 

increased depth of cut. 

 With optimum settings, Vortex machining greatly reduces machining 

times. 
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Vortex example #1 

How to create a Vortex toolpath (2.5D)  

1 Open the file named Vortex_example1.fm 

 There are already operations for rectangular pocket and Vortex in 

this file and it is using a 12mm endmill to machine the pocket. 

2 Run a Centerline Simulation  of the Rectangular pocket operation only to 

see the toolpath similar to that shown below: 

 

3 Check the time of this operation in details. 

4 Unselect the Rectangular Pocket operation in PartView and then select the 

Vortex toolpath. We have set the Z Level increment to 36mm which is the 

depth of the Feature. 

5 Run a Centerline Simulation and then look at the details and compare the 

time. 

6 To familiarize yourself with the different parameters double click on the Vortex 

toolpath in PartView. 
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7 Click on the Rough operation in the feature properties window and select the 

Milling tab. Do not change anything right now.  
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 The user will need to determine the parameters they would prefer 

Vortex to use when calculating our toolpath. Let’s examine these 

settings. 

Vortex min point spacing: - Enter the minimum point spacing at which 

the machine tool can move at the specified feed rate. If the machine 

tool has too many points to process, it cannot sustain the specified 

feed rate. 

Vortex min radius: - Enter the minimum radius of the internal 

trochoids. Vortex toolpaths use trochoidal moves to maintain a 

constant feed rate. Higher feed rates require a larger minimum 

radius.  

Vortex Z lift distance: - Enter a Z distance to lift the tool during 

trochoidal moves to avoid contact between the tool and the surface. 

 There is also a setting called HSM profile corner %. For this setting 

enter the value as a percentage of the tool's diameter. This enables 

arc fitting of profiles to avoid sharp changes of direction in 

internal toolpaths. This attribute applies to NT Spiral, NT 

Continuous Spiral, NT Zigzag and Vortex toolpaths. 

 For now we will leave the settings at the default when we activated 

Vortex, you should only see the HSM profile corner% at 5.000 as 

shown below:  

 



 
Vortex 

                           

 

      
Autodesk FeatureCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           10.7 

8 Select OK 

9 Run a Centerline Simulation to see the altered toolpath.  

 

 You can see (in blue) the helical ramp of the tool and also the channel 

that Vortex creates to clear material out.  Essentially what is taking 

place is that for pockets, the tool spirals down into the pocket before 

using trochoidal paths over the full-width cuts. On completion of the 

initial full-width cut, the trochoids are placed in the corners where the 

maximum tool engagement angle would otherwise be exceeded.  
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10 Double-click on the Rectangular Pocket in the Part View of the Toolbox 

on the left hand side of the FeatureCAM interface to open the Properties of the 

feature once again as before. 

11 Navigate to the rectangular pocket feature’s Milling tab for the rough 

operation again.  

12 Set the Vortex min radius to 5mm and run a Centerline simulation again. 

 

 Notice the larger Vortex trochoids in the toolpath.  Try using 

different values to see the change.  
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 Remember, when using higher feed rates a larger minimum radius 

is required. 

Vortex Example #2  

1 Open the file named Vortex example2.fm 

2 Run a Centerline simulation 
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 Notice the four different pocket toolpaths. The Upper left pocket 

(as seen above) is using Profile Smoothing, Trochoidal milling, a 

large stepdown of the tool, and a small Stepover of the tool.  
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 See results on the next page. 

 

 The Lower Left pocket is using Profile Smoothing, no Trochoidal 

milling, and a small stepdown of the tool, and a big Stepover of the tool.  
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3 From the Results window open the Details tab and look at the Operation 

list. Looking at Op1 and Op2 for Estimated machine times you should see 

similar results as shown below.  

 

 

 Now let’s take a look at the Vortex toolpaths to see what 

improvement can be seen by implementing this strategy. 
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 The Upper Right pocket is using Vortex with a large Stepdown 

and a small min radius. 

 

 

4 From the Results window open the Details tab and look at the Operation 

list. Looking at Op3 Estimated machine time you should see similar results 

as shown on the next page. As you can see this is a significant time saving.  
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 The Lower Right pocket is using Vortex with a large Stepdown 

and a large min radius. 
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 From the Results window open the Details tab and look at the Operation 

list. Looking at Op4 Estimated machine time you should see similar 

results as shown below.  

 

What are the benefits to using a Vortex toolpath? 

 Time savings/efficiency 

 As you can see above there is a time saving of around 60% from the 

trochoidal strategies and almost another minute is saved in the second 

Vortex compared to the first Vortex toolpath. 

 Vortex toolpaths are calculated to follow the shape of the part by creating 

offsets from the part profile. This minimizes air moves for more efficient 

machining of both pockets and cores. 

 Tool life  

 Because Vortex toolpaths have a controlled engagement angle, tools will 

never be overloaded and so will achieve the maximum tool life. Shock 

loading caused by changes in the contact angle is eliminated, preventing 

chipping of the flutes.  

 The stability of the cutting conditions gives constant edge temperatures 

prolonging the life of the tool coating and protecting against heat damage 

to the surface of the part. 

 Remember, Vortex modifies the toolpath so the tool engagement angle 

is never exceeded and the machine tool achieves the specified feed rate. 

The only time the machine tool doesn't run at the specified feed rate is when 

the model geometry (a slot or corner) is smaller than the smallest radius 

that the machine can run at full speed. This should result in better tool life, 

and thus cost to machine a given part.  

 Maximizes your Material Removal Rate 

 Vortex addresses the fundamental problem of conventional roughing 

strategies that can only achieve the optimum cutting conditions during a 

straight-line cut. Unlike other high speed roughing techniques that aim to 

maintain a constant theoretical metal removal rate, the Vortex strategy 

produces toolpaths with a controlled engagement angle for the complete 

operation.  

 This allows you to achieve the optimum cutting conditions that would 

normally be possible only for the straight-line moves across the entire 

toolpath As a result, you can reduce machining times by up to 60%, with 

more consistent material removal rates and feed rate. 
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Vortex Example #3  

Important considerations when creating a Vortex toolpath 

1 Open Vortex example3 

2 Run a Centerline simulation 

 In the image below you will see the pocket feature using Vortex. 

Notice the toolpath that we have now become accustomed to 

seeing.  
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 Now look at the first side feature using Vortex and the toolpath as 

we have seen before.  

 

 IMPORTANT: You can use Vortex to machine a Side feature only 

if the curve is closed. If the curve is open and you select a Vortex 

strategy, NT Spiral will be used instead. 

 Please Note: You will see in the remaining three side features, as shown 

above, that there is no Vortex toolpath generated even though it has 

been set in all three of these features. It is important that you remember 

this and set all your Feeds and Speeds, Stepovers, and Depth of Cut as 

you would have while not using Vortex. The alternative is to close the 

curve. Ask instructor if you are unsure. 
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Vortex Example #4 (3D HSM) 

 This example shows you how to combine Vortex machining with step 

cutting to rapidly remove material. 

 Because Vortex machining cuts with the side of the tool, it is designed 

for solid carbide tools, but there may be other types of tools suitable for 

Vortex. These tools work best when taking deep cuts with a relatively 

small stepover. 

 

 To machine effectively when taking large depths of cut, you must 

ensure the tool engagement angle never exceeds the specified value. 

This eliminates excessive tool load and all full-width cuts. 

FeatureCAM achieves this by introducing trochoidal moves to 

prevent the tool from exceeding the maximum tool engagement 

value. 

 The following images are just for display purposes. Using a 3D 

Model:- 
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 If you create a Vortex toolpath without step cutting it is possible to 

remove vast quantities of material quickly, but leaves large terraces 

of un-machined stock on the part as shown below. 
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 You can minimize the size of these terraces using the Step cutting 

options in the Remachining settings of the feature. 
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 It also machines more of the excess stock. 

 

 To better understand these settings review the following information 

on the next page.  

 Step Cutting: This option machines the terraces that would 

otherwise remain during a Z-level rough toolpath with the same tool 

in the same toolpath. The terraces are machined from bottom to top. 

FeatureCAM increases the feed rate of the intermediate slices as the 

depth of cut gets progressively smaller, which enables a constant 

volume removal rate. 
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 Step up: Enter the distance between intermediate cutting levels. 

 

 Detect material thicker than: Enter a threshold value. FeatureCAM 

ignores rest material that is thinner than the specificed threshold. 

 Expand area by: Enter the distance by which to expand the rest areas, 

measured along the surface. Use with the Detect material thicker than 

value to reduce the areas to be machined to the details (for examples, 

corners), and then to offset these areas slightly to ensure that all the 

detail (for example, on the corners) are machined. 
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 Increase feed for intermediate steps — Select to increase the 

Feed rate of the intermediate slices. Because the stepdown of the 

intermediate slices is less than that of the main slice, you can increase 

the feed rate of the intermediate slices while maintaining the tool 

load. Each intermediate slice can have an increasing feed rate as the 

depth of cut gets progressively smaller. 

 Maximum feed increase % — Enter the maximum allowable 

cutting feed rate for the intermediate slices as a percentage of the 

normal feed rate. This value must be larger than 100%. A value of 

300 means the cutting feed rate of the intermediate slices can be up 

to three times faster than for the main slices. 

Z Start – Z End 

Z start — Enter the distance along the Z axis where the milling operation starts. 

You can use this to save time if the stock material has already been machined 

away in an earlier operation. Use the Pick Z location Icon to pick a location on 

the solid model. 

Z End — Enter the distance along the Z axis where the milling operation 

finishes. You can use this when using short series endmill which are more rigid 

and can be run at higher feed rates. 

Once the endmill length limit has been achieved then a longer endmill can be 

used and the Z end would be the starting point for the longer endmill with a 

new Z end point added. This process would then be repeated until the full depth 

of the component has been fully machined. 

Check surface can also be used to prevent a tool going past a selected face. 
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